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Overview: BlackBerry 1
Enterprise Server

The BlackBerry Enterprise Server is designed to be a secure, centralized link between an organization's wireless network,
communications software, applications, and BlackBerry smartphones. The BlackBerry Enterprise Server integrates with
your organization's existing infrastructure to provide smartphone users with mobile access to your organization's
resources.

You can manage the BlackBerry Enterprise Server, smartphones, and user accounts using the BlackBerry Administration
Service. You can access the BlackBerry Administration Service web application from any computer that can access the
computer that hosts the BlackBerry Administration Service.

You can optionally install BlackBerry Management Studio in your organization's environment to provide a simplified
administrative console for your organization's helpdesk administrators and an integrated view of the BlackBerry Enterprise
Server and other MDM domains. For more information, visit http://www.blackberry.com/go/serverdocs to see the
BlackBerry Management Studio Feature and Technical Overview.


http://www.blackberry.com/go/serverdocs
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Planning a BlackBerry 2
Enterprise Server installation

You can install all BlackBerry Enterprise Server components on one computer, or you can install specific components on
separate computers. You should consider any impact to system resources before you decide where to install the
components.

You install all components on one computer if you do not plan to activate many BlackBerry devices, if you determine that
the computer can manage the volume of traffic for the BlackBerry Enterprise Server components, and if it is acceptable
that the computer has direct access to the Internet, without being located in the DMZ.

If you want to configure high availability, you must install an additional BlackBerry Enterprise Server on a computer that is
separate from the computer that hosts the primary BlackBerry Enterprise Server. During the installation process, you
specify that the duplicate BlackBerry Enterprise Server is the standby BlackBerry Enterprise Server.

For performance information, see the BlackBerry Enterprise Server Performance Benchmarking Guide.

For more information about high availability, see the BlackBerry Enterprise Server Planning Guide.

Installing all BlackBerry Enterprise Server
components on one computer

If you want to evaluate the BlackBerry Enterprise Server or complete a BlackBerry Enterprise Server installation for a small
number of users, you can install all the BlackBerry Enterprise Server components on the same computer.

During the installation process you can choose to install the BlackBerry Collaboration Service and BlackBerry Web Desktop
Manager with the BlackBerry Enterprise Server. All of the other BlackBerry Enterprise Server components are installed
automatically when you install the BlackBerry Enterprise Server.
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Installing the BlackBerry Administration
Service

The BlackBerry Administration Service permits you to manage a BlackBerry Enterprise Server domain through a web-
based application. A BlackBerry Enterprise Server domain consists of one BlackBerry Configuration Database and all
BlackBerry Enterprise Server instances and remote components that use the BlackBerry Configuration Database.

You can install the BlackBerry Administration Service with other BlackBerry Enterprise Server components or by itself on a
separate computer. You can install the BlackBerry Administration Service on a separate computer to limit the impact that
the BlackBerry Administration Service might have on system resources and to prevent administrators in your organization
from accessing any part of the computer that hosts the BlackBerry Enterprise Server. If you install the BlackBerry
Administration Service before you install a BlackBerry Enterprise Server, the installation process will complete successfully
but it will not function properly until the BlackBerry Enterprise Server is installed.

When you install the BlackBerry Administration Service, you can install the BlackBerry Web Desktop Manager and select
whether you want administrators to use Windows authentication or BlackBerry Administration Service authentication to log
in to the BlackBerry Administration Service. You must verify that all administrators have access to the BlackBerry
Administration Service web address (https://<computer_name>:<port>/webconsole/app).

Installing the BlackBerry Attachment
Service

The BlackBerry Attachment Service converts supported attachments into a format that users can view on their BlackBerry
devices. By default, the BlackBerry Enterprise Server includes the BlackBerry Attachment Service.

The BlackBerry Attachment Service might use increased system resources when it processes numerous conversion
requests simultaneously. If you want to increase the number of conversion requests that can occur concurrently without
impacting message delivery, you can install a BlackBerry Attachment Service on a computer that is separate from the
computer that hosts the BlackBerry Enterprise Server.

You can connect multiple BlackBerry Enterprise Server instances and BlackBerry MDS Connection Service instances to a
BlackBerry Attachment Service instance.

When you install the BlackBerry Attachment Service on a computer that is separate from the computer that hosts the
BlackBerry Enterprise Server, the installation process installs the BlackBerry Attachment Service and BlackBerry
Controller. The BlackBerry Controller monitors the BlackBerry Attachment Service and restarts it if it stops responding.
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Installing the BlackBerry Collaboration
Service

The BlackBerry Collaboration Service provides an encrypted connection between your organization's instant messaging
server and the collaboration client on BlackBerry devices so that BlackBerry device users can start and manage instant
messaging conversations on their devices.

If you want to maximize the number of sockets available so that the BlackBerry Collaboration Service can respond to an
increased amount of requests from the collaboration client, you can install the BlackBerry Collaboration Service by itself on
a computer that is separate from the computer that hosts the BlackBerry Enterprise Server. (Microsoft Office
Communications Server 2007 R2 and Microsoft Lync Server 2010 do not use persistent socket connections.)

If you install the BlackBerry Collaboration Service on a separate computer, the installation process installs the BlackBerry
Collaboration Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Collaboration Service
and restarts it if it stops responding.

You can connect multiple BlackBerry Enterprise Server instances to a BlackBerry Collaboration Service instance.

A different type of BlackBerry Collaboration Service exists for each instant messaging environment. For example, a
BlackBerry Collaboration Service exists for Microsoft Office Communications Server 2007, and a different BlackBerry
Collaboration Service exists for IBM Sametime. You can install only one type of BlackBerry Collaboration Service for each
BlackBerry Enterprise Server in your organization's environment. Users can use only one type of collaboration client on
their devices.

Installing the BlackBerry MDS Connection
Service

The BlackBerry MDS Connection Service provides users with access to online content and applications on your
organization's intranet or the Internet. By default, the BlackBerry Enterprise Server includes the BlackBerry MDS
Connection Service.

The BlackBerry MDS Connection Service might use increased system resources when it processes content requests. If you
want to minimize the impact this has on message delivery, you can install the BlackBerry MDS Connection Service by itself
on a computer that is separate from the computer that hosts the BlackBerry Enterprise Server.

You can connect multiple BlackBerry Enterprise Server instances to a BlackBerry MDS Connection Service instance.

When you install the BlackBerry MDS Connection Service on a separate computer, you must assign at least one BlackBerry
Enterprise Server instance to it during the installation process. The BlackBerry MDS Connection Service uses the
BlackBerry Enterprise Server information to connect to the BlackBerry Attachment Service.

10
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When you install the BlackBerry MDS Connection Service on a separate computer, the installation process installs the
BlackBerry MDS Connection Service and BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry MDS
Connection Service and restarts it if it stops responding.

Installing the BlackBerry Router

The BlackBerry Router connects to the wireless network and sends data to and from BlackBerry devices.

You can install a BlackBerry Router with other BlackBerry Enterprise Server components or by itself on a separate
computer. You can install the BlackBerry Router on a computer that is separate from the computer that hosts the
BlackBerry Enterprise Server if you want to install the BlackBerry Router in the DMZ, or to install standby BlackBerry
Router instances as failover components in case the primary BlackBerry Router is unavailable.

You can connect multiple BlackBerry Enterprise Server instances to a BlackBerry Router instance.

If you install the BlackBerry Router on a separate computer, the installation process installs the BlackBerry Router and
BlackBerry Controller. The BlackBerry Controller monitors the BlackBerry Router and restarts it if it stops responding.

11
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Hardware requirements: 3
BlackBerry Enterprise Server

The following are requirements for a BlackBerry Enterprise Server and the BlackBerry Enterprise Server components that
you install on a single computer, and excludes the BlackBerry Collaboration Service. The requirements are for a BlackBerry
Enterprise Server environment that includes users that receive 100 to 200 email messages each day.

You can improve the performance and reliability of the BlackBerry Enterprise Server by installing the BlackBerry Enterprise
Server components on multiple computers. If your BlackBerry Enterprise Server environment supports up to 1000 users,
install the BlackBerry Configuration Database on a computer that is separate from the computer that hosts the BlackBerry
Enterprise Server. If your BlackBerry Enterprise Server environment supports up to 2000 users, install the BlackBerry
Configuration Database and the BlackBerry Administration Service on computers that are separate from the computer that
hosts the BlackBerry Enterprise Server.

Item Requirement

BlackBerry Enterprise Server that * Single processor, 2.0 GHz Intel Xeon (two processors recommended)
supports up to 200 users o DEB e
® 64-bit operating system: Two 64 GB drives (minimum), RAID 1
e 32-bit operating system: Two 36 GB drives (minimum), RAID 1
e 150 MB disk space for the BlackBerry Enterprise Server

e 400 MB disk space for the BlackBerry Administration Service

e Approximately 2 MB per user each day for log files (100 email messages per
user)

BlackBerry Enterprise Server that e Two processors, 2.0 GHz Intel Xeon
supports up to 500 users o DER T
e 64-bit operating system: Two 64 GB drives (minimum), RAID 1
e 32-bit operating system: Two 36 GB drives (minimum), RAID 1
e 150 MB disk space for the BlackBerry Enterprise Server

e 400 MB disk space for the BlackBerry Administration Service

e Approximately 2 MB per user each day for log files (100 email messages per
user)

12
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Item

BlackBerry Enterprise Server that
supports up to 1000 users

BlackBerry Enterprise Server that
supports up to 2000 users

Hardware requirements: BlackBerry Enterprise Server

Requirement

e Two processors, 2.0 GHz Intel Xeon

e 3 GBof memory

e 64-bit operating system: Two 64 GB drives (minimum), RAID 1
e 32-bit operating system: Two 36 GB drives (minimum), RAID 1
e 150 MB disk space for the BlackBerry Enterprise Server

e 400 MB disk space for the BlackBerry Administration Service

e Approximately 2 MB per user each day for log files (100 email messages per
user)

e Two processors, 2.8 GHz Intel Xeon or two processors, 1.86 GHz Intel Xeon
5100 Series (Dual Core)

e 4GB of memory

e 64-bit operating system: Two 64 GB drives (minimum), RAID 1 or four 64 GB
drives (minimum), RAID 1+0

e 32-bit operating system: Two 36 GB drives (minimum), RAID 1 or four 36 GB
drives (minimum), RAID 1+0

e 150 MB disk space for the BlackBerry Enterprise Server
e 400 MB disk space for the BlackBerry Administration Service

e Approximately 2 MB per user each day for log files (100 email messages per
user)

13



Installation and Configuration Guide System requirements

System requirements

For information about calculating hardware requirements, visit www.blackberry.com/go/serverdocs to see the BlackBerry
Enterprise Server Capacity Calculator and BlackBerry Enterprise Server Performance Benchmarking Guide.

System requirements: BlackBerry
Enterprise Server

Item Requirement

operating system Any of the following operating systems:

e Windows Server 2003 SP2 (32-bit or 64-bit)

e Windows Server 2003 R2 SP2 (32-bit or 64-bit)
e Windows Server 2008 SP2 (32-bit or 64-bit)

e Windows Server 2008 R2

e Windows Server 2008 R2 SP1

e Windows Server 2012

Microsoft Exchange system tools Any of the following system tools:

e Microsoft Exchange 2003 SP2 System Manager
e Microsoft Exchange Server MAPI Client and CDO 1.2.1

To support Microsoft Exchange Server 2010, you must install version
6.5.8211.0 or later of the Microsoft Exchange Server MAPI Client and CDO
1.2.1.

For more information about installing MAPI and CDO patches on your
organization's BlackBerry Enterprise Server, visit support.microsoft.com to read
article 917481 and visit www.blackberry.com/go/kbhelp to read article
KB15779.

Microsoft Exchange organization of the The same Microsoft Exchange organization that the messaging server uses
system tools for the messaging server

14
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Item

CDQ library

Unicode support for calendars

static IP address for the computer

browser

media player

network proximity

File and Printer Sharing

System requirements

Requirement

To support the latest version of Microsoft Exchange Server in your organization's
environment, the latest version of the CDO library that applies to the Microsoft
Exchange Server version

To support Microsoft Exchange Server 2003, the following Microsoft hotfixes:

e 913643 on the messaging server
e 923537 on the computer that hosts the BlackBerry Enterprise Server

To install the BlackBerry Administration Service in a pool, a static IP address for
the computer that hosts the component

Windows Internet Explorer 7.0 to 8.0 with language preferences configured to
display encoded web pages

One of the following:

e ifusing Windows Server 2008, to support audio attachments, Windows
Media Format SDK (for more information, visit msdn.microsoft.com and
search Windows Media Format SDK)

e ifusing Windows Server 2003, to support audio attachments, Windows
Media Player 9 or later

A high-speed, switched connection between the BlackBerry Enterprise Server
and messaging servers

If using Windows Server 2003, to permit the BlackBerry Controller to monitor
BlackBerry Enterprise Server components, install File and Printer Sharing

For more information, see the documentation for Windows Server

System requirements: BlackBerry
Administration Service and BlackBerry Web
Desktop Manager

The following system requirements apply to the computer that you install the BlackBerry Administration Service and

BlackBerry Web Desktop Manager on.

15


http://msdn.microsoft.com

Installation and Configuration Guide

System requirements

Item Requirement

operating system Any of the following operating systems:

Windows Server 2003 SP2 (32-bit or 64-bit)
Windows Server 2003 R2 SP2 (32-bit or 64-bit)
Windows Server 2008 SP2 (32-bit or 64-bit)
Windows Server 2008 R2

Windows Server 2008 R2 SP1

Windows Server 2012

Microsoft hotfix 955839 installed on the computer that hosts the BlackBerry
Administration Service and BlackBerry Web Desktop Manager

memory A minimum 1.2 GB of memory

hardware load balancer If you configure high availability for the BlackBerry Administration Service using
a hardware load balancer, you must implement session persistence for SSL
connections. For information on how to implement session persistence, contact
the vendor of your hardware load balancer.

outgoing data connection For the BlackBerry Administration Service, an HTTPS connection using port
number 443

System requirements: BlackBerry
Enterprise Server databases

Item Requirement

database management system Any of the following database management systems:

16

Microsoft SQL Server 2005 SP3 (32-bit or 64-bit)
Microsoft SQL Server 2005 SP4 (32-bit or 64-bit)
Microsoft SQL Server 2005 Express SP3

Microsoft SQL Server 2008 SP2 (32-bit or 64-bit)
Microsoft SQL Server 2008 SP3 (32-bit or 64-bit)
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Item

collation setting

database connectivity

nested triggers

database mirroring

System requirements

Requirement

Microsoft SQL Server 2008 R2 (32-bit or 64-bit)

Microsoft SQL Server 2008 R2 SP1 (32-bit or 64-bit)
Microsoft SQL Server 2008 R2 SP2 (32-bit or 64-bit)
Microsoft SQL Server 2008 Express SP3 (32-bit or 64-bit)
Microsoft SQL Server 2008 R2 Express SP1 (32-bit or 64-bit)
Microsoft SQL Server 2008 R2 Express SP2 (32-bit or 64-bit)
Microsoft SQL Server 2012 (32-bit or 64-bit)

To configure collation settings, the following conditions:

database server collation configured to default case-insensitive

BlackBerry Configuration Database collation configured to default case-
insensitive

collation must be the same for the Microsoft SQL Server instance and the
database server that hosts the BlackBerry database notification system
(BlackBerry Configuration Database)

default collations are suggested though non-default collations are supported
(for more information, visit www.blackberry.com/go/kbhelp to read articles
KB04785 and KB15534)

TCP/IP network protocols turned on

No count option turned off

Nested trigger support turned on. For more information, visit
msdn.microsoft.com to read article ms178101.

To support database mirroring for the BlackBerry Configuration Database, the
following conditions:

Any of the following database management systems:

e Microsoft SQL Server 2005 SP3 Enterprise Edition or Standard Edition
(32-bit or 64-bit)

e Microsoft SQL Server 2005 SP4 Enterprise Edition or Standard Edition
(32-bit or 64-bit)

17
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Item Requirement
e Microsoft SQL Server 2008 SP1 Enterprise Edition or Standard Edition
(32-bit or 64-bit)

e Microsoft SQL Server 2008 SP2 Enterprise Edition or Standard Edition
(32-bit or 64-bit)

e Microsoft SQL Server 2008 R2 Enterprise Edition or Standard Edition
(32-bit or 64-bit)

e the mirror database must reside on a different computer from the principal
database

e the Microsoft SQL Server instances for both the principal and mirrored
databases must be the same version and edition

e only use static port number 1433
® donot use named instances
e verify that the SQL Server Browser service is running

e turn off the Named Pipes option in the Microsoft SQL Server Native Client on
the computers that host the BlackBerry Enterprise Server instances

database transactional replication To support database transactional replication for the BlackBerry Configuration
Database, the following conditions:

e the database server must be Microsoft SQL Server 2005 SP3 or later

e the database server that hosts the replicated database must use the same
version and build as the database server that hosts the primary database

System requirements: BlackBerry
Attachment Service

The following system requirements apply to the computer that you install the BlackBerry Attachment Service on.

Item Requirement

operating system Any of the following operating systems:

18
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Item

media player

browser

System requirements

Requirement

e Windows Server 2003 SP2 (32-bit or 64-bit)

e Windows Server 2003 R2 SP2 (32-bit or 64-bit)
e Windows Server 2008 SP2 (32-bit or 64-bit)

e Windows Server 2008 R2

e Windows Server 2008 R2 SP1

e Windows Server 2012

One of the following:

e f using Windows Server 2008, to support audio attachments, Windows
Media Format SDK (for more information, visit msdn.microsoft.com and
search Windows Media Format SDK)

e f using Windows Server 2003, to support audio attachments, Windows
Media Player 9 or later

Windows Internet Explorer 7.0 to 8.0 with language preferences configured to
display encoded web pages

System requirements: BlackBerry
Collaboration Service

The following system requirements apply to the computer that you install the BlackBerry Collaboration Service on.

Item

operating system

Requirement

Unless otherwise stated, any of the following operating systems:
e Windows Server 2003 SP2 (32-bit or 64-bit)

e Windows Server 2003 R2 SP2 (32-bit or 64-bit)

e Windows Server 2008 SP2 (32-bit or 64-bit)

e Windows Server 2008 R2

e Windows Server 2008 R2 SP1
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Item

IBM Sametime

Novell GroupWise Messenger

Microsoft Office Live Communications
Server 2005 or Microsoft Office
Communications Server 2007

Microsoft Office Communications
Server 2007 R2

20

System requirements

Requirement

e Windows Server 2012

IP address of the computer that hosts the BlackBerry Collaboration Service
added to the CommunityConnectivity document on the IBM Sametime server

SSL authentication turned on for the Novell GroupWise Messenger agents on the
Novell GroupWise Messenger server

The latest Microsoft hotfixes installed

e Any of the following operating systems:

Windows Server 2003 R2 SP2 (64-bit)
Windows Server 2008 SP2 (64-bit)
Windows Server 2008 R2

Windows Server 2008 R2 SP1
Windows Server 2012

e The latest Microsoft hotfixes installed

e The BlackBerry Collaboration Service installed in the same Microsoft Active
Directory domain as Microsoft Office Communications Server 2007 R2

e The Windows account that runs the BlackBerry Collaboration Service added
to one of the following groups:

RTCUniversalServerAdmins group, to automatically provision the
BlackBerry Collaboration Service as a trusted service in Microsoft Active
Directory (for more information, visit msdn.microsoft.com to read about
required Microsoft Active Directory permissions)

RTCComponentUniversalServices group, if you use another account with
the required permissions (RTCUniversalServerAdmins) to manually
provision the BlackBerry Collaboration Service as a trusted service in
Microsoft Active Directory (for more information, see "Manually provision
the BlackBerry Collaboration Service as a trusted application")

e Microsoft .NET Framework 3.5 SP1
e Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe)

e Microsoft SQL Server Native Client (sqlncli_x64.msi)
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Item

Microsoft Lync Server 2010

System requirements

Requirement

Microsoft Unified Communications Managed APl 2.0 Core Redist 64-bit
(ucmaredist.msi)

Microsoft Office Communications Server 2007 R2, Core Components
(ocscore.msi)

The required certificate installed in the Personal Certificate folder for the
local computer account

For detailed instructions about the Microsoft install packages and installing the
required certificate, see "Preparing the computer that hosts the BlackBerry
Collaboration Service for use with Microsoft Office Communications Server 2007
R2".

Any of the following operating systems:

e Windows Server 2003 R2 SP2 (64-bit)
¢ Windows Server 2008 SP2 (64-bit)

e Windows Server 2008 R2

e Windows Server 2008 R2 SP1

e Windows Server 2012

The latest Microsoft hotfixes installed

The BlackBerry Collaboration Service installed in the same Microsoft Active
Directory domain as Microsoft Lync Server 2010

The Windows account that runs the BlackBerry Collaboration Service added
to one of the following groups:

e RTCUniversalServerAdmins group, to automatically provision the
BlackBerry Collaboration Service as a trusted service in Microsoft Active
Directory (for more information, visit msdn.microsoft.com to read about
required Microsoft Active Directory permissions)

e RTCComponentUniversalServices group, if you use another account with
the required permissions (RTCUniversalServerAdmins) to manually
provision the BlackBerry Collaboration Service as a trusted service in
Microsoft Active Directory (for more information, see "Manually provision
the BlackBerry Collaboration Service as a trusted application™)

Microsoft .NET Framework 3.5 SP1
Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe)
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Item

System requirements

Requirement

e Microsoft SQL Server Native Client (sqlncli_x64.msi)

e Microsoft Unified Communications Managed API 2.0 Core Redist 64-bit (to
download ucmaredist.msi, visit the Volume Licensing Service Center at
www.microsoft.com)

e Microsoft Office Communications Server 2007 R2, Core Components (to
download ocscore.msi, visit the Volume Licensing Service Center at
www. microsoft.com)

e The required certificate installed in the Personal Certificate folder for the
local computer account

For detailed instructions about the Microsoft install packages and installing the
required certificate, see "Preparing the computer that hosts the BlackBerry
Collaboration Service for use with Microsoft Lync Server 2010".

System requirements: BlackBerry MDS
Connection Service

The following system requirements apply to the computer that you install the BlackBerry MDS Connection Service on.

Item

operating system

RSA Authentication Agent

memory
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Requirement
Any of the following operating systems:

e Windows Server 2003 SP2 (32-bit or 64-bit)

e Windows Server 2003 R2 SP2 (32-bit or 64-bit)
e Windows Server 2008 SP2 (32-bit or 64-bit)

e Windows Server 2008 R2

e Windows Server 2008 R2 SP1

e Windows Server 2012

To support enhanced network authentication (optional), RSA Authentication
Agent 6.1 for Windows Server 2003 or RSA Authentication Agent 7.0.1 for
Windows Server 2008.

One of the following:
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Item Requirement

e ifyouinstall a central push server and less than 1000 user accounts, a
minimum of 1024 MB

e ifyou install a central push server and more than 1000 user accounts, a
minimum of 3 GB

e ifyou do not install a central push server, a minimum of 512 MB

System requirements: BlackBerry Router

To install the BlackBerry Router on a computer that is separate from the computer that hosts the BlackBerry Enterprise
Server, any of the following operating systems:

Windows Server 2003 SP2 (32-bit or 64-bit)
Windows Server 2003 R2 SP2 (32-bit or 64-bit)
Windows Server 2008 SP2 (32-bit or 64-bit)
Windows Server 2008 R2

Windows Server 2008 R2 SP1

Windows Server 2012

System requirements for your organization's
environment

The following system requirements apply when you configure single sign-on authentication for the BlackBerry
Administration Service and BlackBerry Web Desktop Manager or configure the BlackBerry MDS Connection Service to
support Integrated Windows authentication.

Item Requirement
network services Microsoft Active Directory running at Windows Server 2003 domain functional level or
higher
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System requirements

Item Requirement

application server For the BlackBerry MDS Connection Service to support Integrated Windows
authentication, Microsoft IIS 6.0 or 7.0 using Integrated Windows authentication

file server For the BlackBerry MDS Connection Service to support Integrated Windows
authentication, Windows Server 2003 file services or Windows Server 2008 file

services

System requirements: Computers for
BlackBerry Web Desktop Manager and
BlackBerry Administration Service users

Item

browser

browser settings for Windows Internet
Explorer
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Requirement

Windows Internet Explorer 7.0 to 8.0
Mozilla Firefox 3.6+

Google Chrome 4.0+

Safari 4 for Mac

Windows Internet Explorer 7 or later provides optimal support for BlackBerry
Web Desktop Manager features and BlackBerry Administration Service features.
Depending on the browser that you use, the BlackBerry Web Desktop Manager
and BlackBerry Administration Service might not recognize BlackBerry devices
and the browser might prevent you from activating devices that are connected
to the computer, backing up and restoring device data, or adding or updating
device applications.

To support browser access, you must configure the following settings:

language preferences configured to display encoded web pages

Microsoft hotfix 955839 installed on the users' computers to make sure the
correct time zones are displayed

the following settings turned on to support Microsoft ActiveX:
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Item

browser settings for Firefox, Safari, and
Google Chrome

System requirements

Requirement

e Automatic prompting for Microsoft ActiveX controls
e Download signed Microsoft ActiveX controls
e Run Microsoft ActiveX controls and plug-ins

e Script Microsoft ActiveX controls marked safe for scripting

support for JavaScript
cookies turned on
support for TLS or SSL

the SSL certificate installed to permit trusted connections to the BlackBerry
Administration Service

if using Windows Vista, the BlackBerry Administration Service web address
added as a trusted web site and Enable protected mode cleared

if you configure single sign-on authentication for the BlackBerry
Administration Service

e the BlackBerry Web Desktop Manager and BlackBerry Administration
Service web sites assigned to the local intranet zone

e Enable Integrated Windows Authentication selected

if you do not configure single sign-on authentication for the BlackBerry
Administration Service

e the BlackBerry Web Desktop Manager and BlackBerry Administration
Service web sites assigned to the local intranet or trusted sites security
zone

To support browser access, you must configure the following settings:

support for JavaScript
cookies turned on
support for TLS or SSL

to permit trusted connections to the BlackBerry Administration Service, the
SSL certificate installed

Single sign-on authentication for the BlackBerry Administration Service is not
supported by Google Chrome.
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System requirements: Messaging server

Any of the following messaging servers that are located in close proximity to where you want to install the primary
BlackBerry Enterprise Server:

Microsoft Exchange 2010 SP1 Multi-Tenant Deployment is supported with the following conditions:
e Microsoft Exchange Server 2010 SP1 Update Rollup 3

e To manage calendars, enable Microsoft Exchange Web Services

e Configure the BlackBerry Enterprise Server to run without public folders

Microsoft Exchange Server 2010 SP1

Microsoft Exchange Server 2010 and Microsoft Exchange Server 2010 Update Rollup 1 (Microsoft Exchange Server
MAPI Client and CDO 1.2.1 must be version 6.5.8211.0 or later to support Microsoft Exchange Server 2010)

Microsoft Exchange Server 2007 SP2 or SP3
Microsoft Exchange Server 2003 SP2

Any of the following Microsoft Exchange mixed environments:

e Microsoft Exchange Server 2003 and 2007

* Microsoft Exchange Server 2007 SP2 and 2010

e Microsoft Exchange Server 2007 SP2 and 2010 SP1
* Microsoft Exchange Server 2007 SP3 and 2010

e Microsoft Exchange Server 2007 SP3 and 2010 SP1

System requirements: Firewall

To install the BlackBerry Enterprise Server, configure a firewall or proxy firewall with the following conditions:
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Exclusive use of port 3101 to open and maintain an outbound, bidirectional TCP/IP connection to an external server
Support for resolving Internet addresses that use DNS

For proxy firewalls, transparency of the proxy server

System requirements
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System requirements: Instant messaging
server

To install the BlackBerry Enterprise Server, any of the following instant messaging servers:

IBM Sametime 7.0 Community Server

IBM Sametime 7.5 Community Server

IBM Sametime 8.0 Community Server

IBM Sametime 8.0.1 Community Server

IBM Sametime 8.0.2 Community Server

IBM Sametime 8.5 Community Server

Microsoft Office Live Communications Server 2005 SP1 Standard or Enterprise
Microsoft Office Communications Server 2007 Standard or Enterprise
Microsoft Office Communications Server 2007 R2

Microsoft Lync Server 2010

Novell GroupWise Messenger 2.0 or later

Supported features and environments

Item BlackBerry Enterprise Server

Virtual environment For information, please visit www.blackberry.com to read KB 29661.

Enhanced network All BlackBerry Enterprise Server components support RSA Authentication Agent 6.1 for
authentication Windows Server 2003 and RSA Authentication Agent 7.0.1 for Windows Server 2008.

P BlackBerry Enterprise Server components support only IPv4 for TCP/IP connections.

SNMP monitoring The BlackBerry Enterprise Server components support the SNMP service.

Remote access The BlackBerry Enterprise Server components support remote access by administrators who

use Remote Desktop Connection.
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Unsupported environments

Item Description

DMz The BlackBerry Enterprise Server and BlackBerry Enterprise Server
components, with the exception of the BlackBerry Router, do not support
installation in a DMZ.

messaging server The BlackBerry Enterprise Server for Microsoft Exchange (and all BlackBerry
Enterprise Server components) does not support installation on the computer
that hosts the messaging server.

email application The BlackBerry Enterprise Server and BlackBerry Enterprise Server components
do not support installation on computers that host email applications such as
Microsoft Outlook. Email applications use data files that can cause conflicts with
the BlackBerry Enterprise Server components. As a result, the BlackBerry
Enterprise Server components might not function as expected.

instant messaging server Any of the following environments:

e |fyou configure the BlackBerry Enterprise Server for high availability, the
primary BlackBerry Enterprise Server instance and standby BlackBerry
Enterprise Server instance do not support more than one type of instant
messaging server in a BlackBerry Enterprise Server pair. For example, if you
install the BlackBerry Collaboration Service for use with Microsoft Office
Communications Server 2007 on the primary instance, you must also install
the BlackBerry Collaboration Service for use with Microsoft Office
Communications Server 2007 on the standby instance.

e A BlackBerry Enterprise Server or BlackBerry Enterprise Server pair that
connects to multiple instances of the BlackBerry Collaboration Service does
not support more than one type of instant messaging server. You must use
the same type of instant messaging server for each local or remote
BlackBerry Collaboration Service that you connect to a BlackBerry
Enterprise Server or BlackBerry Enterprise Server pair.

BlackBerry Collaboration Service If you install the BlackBerry Collaboration Service for use with Microsoft Lync
Server 2010, the BlackBerry Collaboration Service does not support using
ocscore.msi or ucmaredist.msi from the Microsoft Lync Server 2010 installation
files on the computer that you install the BlackBerry Collaboration Service on.
You must use ocscore.msi and ucmaredist.msi from Microsoft Office
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Item

BlackBerry Attachment Service

Remote Desktop Services or Terminal
Services

System requirements

Description

Communications Server 2007 R2. For more information, visit the Volume
Licensing Service Center at www.microsoft.com.

You must install the software update for KB22953 on Windows Server 2008 if
you want the BlackBerry Attachment Service to support .mp3 audio files on
BlackBerry devices and all audio formats on BlackBerry 7100 Series devices
that support CDMA networks. To download the software update for KB22953,
visit www.blackberry.com/support/downloads/.

The BlackBerry Enterprise Server and BlackBerry Enterprise Server components
do not support installation on a computer that you installed Remote Desktop
Services or Terminal Services on.
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Preinstallation tasks

Configuring a Microsoft Exchange 2010
messaging environment

Create a Windows account that has a Microsoft
Exchange 2010 mailbox

You must create a Windows account with a Microsoft Exchange 2010 mailbox so that the Windows account can
authenticate with the Microsoft Exchange Server.

Before you begin: If you want free/busy lookups to work in Microsoft Outlook 2003 and earlier, you must configure
Microsoft Exchange 2010 to support Microsoft Outlook 2003 and earlier by creating a public folder database. For more
information about supporting Microsoft Outlook 2003 and earlier, visit http://support.microsoft.com to read article 555851
and visit http://technet.microsoft.com to read articles 123694, 124270, 397221, and 691120.

1. Onthe computer that hosts Microsoft Exchange, log in using an administrator account that has the permission to
create accounts.

2. Open the Microsoft Exchange Management Console.
3. Create an account and mailbox that you name BESAdmin.

4.  To permit the BlackBerry Enterprise Server to check if a BlackBerry device user has permission to access a public
folder, assign the Owner permission for all public folders to the administrator account.

After you finish:

e To verify that you created the Windows account, log in to a computer using the Windows account.

e \Verify that the Windows account is not a member of the Domain Administrators group in Microsoft Active Directory.
e \Verify that BlackBerry device users have Read permissions and Visible permissions to public folders.

e To permit BlackBerry device users to check the availability of meeting participants using BlackBerry Device Software
4.5 or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit
http://technet.microsoft.com to read articles 629523 and 691129.

30


http://support.microsoft.com
http://technet.microsoft.com
http://technet.microsoft.com

Installation and Configuration Guide Preinstallation tasks

Configure Microsoft Exchange 2010 permissions for
the Windows account

Before you begin:

Verify the domain name in Microsoft Active Directory. When you set the permissions, you must match the domain name in
Microsoft Active Directory.

1.  Onacomputerthat hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management
Shell.

2. Type Get-MailboxDatabase | Add-ADPermission -User "BESAdmin" -AccessRights ExtendedRight -
ExtendedRights Receive-As, ms-Exch-Store-Admin, ms-Exch-Store-Visible.

3.  Type Add-RoleGroupMember "View-Only Organization Management" -Member "BESAdmin".
4. Do one of the following:
e To set the permissions at the organizational unit level, type the following command:

Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights Send-As -User
"BESAdmin" -ldentity "OU=<organizational_unit>,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"

For example, if the organizational unit is Texas and the domain name is example.organization.net, type Texas for
<organizational_unit>, example for <domain_1>, organization for <domain_2>, and net for <domain_3>.
e Toset the permissions at the common name level, type the following command:

Add-ADPermission -InheritedObjectType User -InheritanceType Descendents -ExtendedRights Send-As -User
"BESAdmin" -ldentity "CN=<common_name>,DC=<domain_1>,DC=<domain_2>,DC=<domain_3>"

For example, if the common name is Users and the domain name is example.organization.net, type Users for
<common_name>, example for <domain_1>, organization for <domain_2>, and net for <domain_3>.

In each command, <domain_1>, <domain_2>, and <domain_3> form the internal Microsoft Active Directory domain
(if internal and external domain names are different). You can contact your Microsoft Active Directory administrator
for information about distinguished names.

After you finish: If you create a mailbox database for Microsoft Exchange, repeat step 2.

Increase the maximum number of connections to the
Address Book service in Microsoft Exchange 2010

By default, Microsoft Exchange 2010 limits the maximum number of connections from the BlackBerry Enterprise Server to
the Address Book service to 50. To permit the BlackBerry Enterprise Server to run, you must increase the number of
permitted connections to a large value (for example, 100,000).
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Before you begin: You must complete this task if the messaging server that the BlackBerry Enterprise Server uses is
Microsoft Exchange 2010. If the messaging server is Microsoft Exchange 2010 SP1, you can change the
MaxSessionsPerUser settings using client throttling policies.

1. Onthe computer that hosts the Microsoft Exchange CAS server, in <drive>:\Program Files\Microsoft\Exchange Server
\V14\Bin, in a text editor, open the microsoft.exchange.addressbook.service.exe.config file.

2. Change the value of the MaxSessionsPerUser key to 100000.
3. Save and close the file.

4.  Restart the Address Book service.

Turn off client throttling in Microsoft Exchange 2010

By default, Microsoft Exchange 2010 uses client throttling policies to track the bandwidth that each Microsoft Exchange
user consumes and enforce bandwidth limits as necessary. The policies affect the performance of the BlackBerry
Enterprise Server, so you should turn off client throttling for the Windows account that has a Microsoft Exchange mailbox.

1.  Onacomputerthat hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management
Shell.

2. Type New-ThrottlingPolicy BESPolicy.

3. Type the following command:

Set-ThrottlingPolicy BESPolicy -RCAMaxConcurrency $null -RCAPercentTimelnAD $null -RCAPercentTimelnCAS
$null -RCAPercentTimelnMailboxRPC $null -EWSMaxConcurrency $null -EWSPercentTimelnAD $null -
EWSPercentTimelnCAS $null -EWSPercentTimelnMailboxRPC $null -EWSMaxSubscriptions $null -
EWSFastSearchTimeoutIinSeconds $null -EWSFindCountLimit $null

4.  Type Set-Mailbox "BESAdmin" -ThrottlingPolicy BESPolicy.

Configure a management role and scope for Microsoft
Exchange Web Services

If you want the BlackBerry Enterprise Server to use Microsoft Exchange Web Services to manage calendars on BlackBerry
devices, you must configure a management role and scope for Microsoft Exchange Web Services in Microsoft Exchange
2010.

For more information about configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services, see the
BlackBerry Enterprise Server Administration Guide.

1.  Onacomputer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management
Shell.

2. Do one or more of the following:
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To enable a service account for all users in an organization, type the following command:

New-ManagementRoleAssignment -Name: <role_name> -Role Applicationlmpersonation -User:
<account_name>

To create a management scope for a specific group, type the following command:

New-ManagementScope -Name: <scope_name> —RecipientRestrictionFilter: <member_names> -
RecipientRoot: <domain_name>

To enable a service account for all users in a scope, type the following command:

New-ManagementRoleAssignment —Name: <role_name> —Role Applicationimpersonation —User:
<account_name> —CustomRecipientWriteScope: <scope_name>

Configure the BlackBerry Enterprise Server to run
without public folders

If you did not install any public folders in Microsoft Exchange, you must configure the BlackBerry Enterprise Server to run
without public folders by changing a registry key.

1.

2
3.
4

© N o O

On each computer that hosts the BlackBerry Enterprise Server, click Start > Run.

In the Open field, type regedit.
Click OK.

Perform one of the following actions:

If you are running a 32-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft
\Windows Messaging Subsystem\CDO.

If you are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node
\Microsoft\Windows Messaging Subsystem.

If the CDO registry key does not exist, create a registry key that you name CDO.

In the CDO registry key, if the DWORD value does not exist, create a DWORD value that you name Ignore No PF.
Change the DWORD value to 1.
Click OK.
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Permit meeting requests from outside of your
organization when using Microsoft Exchange Web
Services for Microsoft Exchange 2010

By default, the BlackBerry Enterprise Server uses Microsoft Exchange Web Services to manage calendars on BlackBerry
devices. Each time you add a new Microsoft Exchange mailbox, you must configure the calendar settings in Microsoft
Exchange to permit BlackBerry device users to receive meeting requests from outside of your organization when using
Microsoft Exchange Web Services.

1. Onacomputer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management
Shell.

2. Foreach Microsoft Exchange Server that hosts users, type the following command:
Get-Mailbox -server<messaging-server name>| Set-CalendarProcessing -ProcessExternalMeetingMessages $true

Configuring a Microsoft Exchange 2007/
messaging environment

Create a Windows account that has a Microsoft
Exchange 2007 mailbox

You must create a Windows account that has a Microsoft Exchange 2007 mailbox so that the Windows account can
authenticate with the Microsoft Exchange Server.

Before you begin: You must configure Microsoft Exchange 2007 to support versions of Microsoft Outlook that are earlier
than 2007 by creating a public folder database. For more information about supporting versions of Microsoft Outlook that
are earlier than 2007, visit http://support.microsoft.com to read article 555851 and visit http://technet.microsoft.com to
read articles 123694, 124270, 397221, and 691120.

1. Onthe computer that hosts Microsoft Exchange, log in using an administrator account that has the correct
permission to create accounts.

2. Open the Microsoft Exchange Management Console.

3. Create an account and mailbox that you name BESAdmin.

34


http://support.microsoft.com
http://technet.microsoft.com

Installation and Configuration Guide Preinstallation tasks

4. To permit the BlackBerry Enterprise Server to check if a user has permissions for a public folder, assign the Owner
permission for all public folders to the administrator account.

After you finish:

e To verify that you created the Windows account, log in to a computer using the Windows account.

e Verify that the Windows account is not a member of the Domain Administrators group in Microsoft Active Directory.
e Verify that BlackBerry device users have Read and Visible permissions to public folders.

e To permit BlackBerry device users to check the availability of meeting participants in BlackBerry Device Software 4.5
or later, configure the Schedule+ Free/Busy information for the system public folder. For more information, visit http://
technet.microsoft.com to read articles 629523 and 691129.

Configure Microsoft Exchange 2007 permissions for
the Windows account

1.  Onacomputer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management
Shell.
2. Perform one of the following actions:
e |fyou login to Microsoft Exchange Server 2007, type add-exchangeadministrator "BESAdmin" -role
ViewOnlyAdmin.

e |fyou login to another computer, type get-mailboxserver "<messaging_server_name>" | add-
exchangeadministrator "BESAdmin" -role ViewOnlyAdmin.
3.  Foreach Microsoft Exchange Server 2007 instance that hosts BlackBerry device users, type the following command:

get-mailboxserver "<messaging_server_name>" | add-adpermission -user "BESAdmin" -accessrights
ExtendedRight -extendedrights Receive-As, ms-Exch-Store-Admin

Permit users to send email messages in a Microsoft
Exchange environment

To permit BlackBerry device users to send email messages, you must configure Send As permissions for the Microsoft
Active Directory user object that contains users. This task describes how to configure the Send As permissions for the
entire Windows domain, but you can also configure the permissions at the user object level or on a container of user
objects.

For more information about Send As permissions and the BlackBerry Enterprise Server, visit www.blackberry.com/btsc to
read article KB04707. For more information about assigning Send As permissions permissions to multiple user accounts,
visit support.microsoft.com to read article 912918.

35


http://technet.microsoft.com
http://technet.microsoft.com
http://www.blackberry.com/btsc
http://support.microsoft.com

Installation and Configuration Guide Preinstallation tasks

1. Logintoacomputerinthe Windows domain as an administrator that has permissions to change user objects in
Microsoft Active Directory.

On the taskbar, click Start > Administrative Tools > Active Directory Users and Computers.
On the View menu, click Advanced Features.

Right-click the domain root. Click Properties.

On the Security tab, click Advanced.

Click Add.

Type the name of the Windows account that you created (for example, BESAdmin).

Click Check Names.

Click OK.

© o N o oA~ WD
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Perform one of the following actions:
e |fyou are running Windows Server 2003, in the Apply drop-down list, click User Objects.

e |fyouare running Windows Server 2008, in the Apply drop-down list, click Descendant User Objects.
11. Inthe Allow column, select the Send As check box.
12. Click Apply.
13. Click OK.

Permit meeting requests from outside of your
organization when using Microsoft Exchange Web
Services for Microsoft Exchange 2007/

By default, the BlackBerry Enterprise Server uses Microsoft Exchange Web Services to manage calendars on BlackBerry
devices. Each time you add a new Microsoft Exchange mailbox, you must configure the calendar settings in Microsoft
Exchange to permit BlackBerry device users to receive meeting requests from outside of your organization when using
Microsoft Exchange Web Services.

1.  Onacomputer that hosts the Microsoft Exchange Management Shell, open the Microsoft Exchange Management
Shell.

2. Foreach Microsoft Exchange Server that hosts users, type the following command:

Get-Mailbox -server<messaging-server name>| Set-MailboxCalendarSettings -ProcessExternalMeetingMessages
$true
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Configuring a Microsoft Exchange 2003
messaging environment

Create a Windows account that has a Microsoft
Exchange 2003 mailbox

You must create a Windows account that has a Microsoft Exchange 2003 mailbox so that the Windows account can
authenticate with the Microsoft Exchange messaging server.

1.  Onanycomputerin the Windows domain, on the taskbar, click Start > Programs > Microsoft Exchange > Active
Directory Users and Computers.

2. Create an account that has the following attributes:
e Name: BESAdmin

¢ Group membership: Domain User
3. Create a Microsoft Exchange mailbox for the account.

4.  To activate the new mailbox, send a test email message.

After you finish:

If you cannot see the Windows account in the Microsoft Active Directory to verify that you created it, log in to a computer
using the Windows account.

For more information about the Send As permission and the BlackBerry Enterprise Server, visit www.blackberry.com to
read KB04707.

For more information about assigning the Send As permission to multiple user accounts, visit www.support.microsoft.com
toread article 912918.

Configure Microsoft Exchange 2003 permissions for
the Windows account

On each Microsoft Exchange 2003 server that hosts BlackBerry device users, you must configure Microsoft Exchange
permissions for the Windows account (for example, BESAdmin) that you want to use to install the BlackBerry Enterprise
Server components.
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This task describes how to configure the Microsoft Exchange permissions at the administrative group level for every
Microsoft Exchange 2003 server that hosts BlackBerry device users but you can also configure the permissions at other
levels, such as at the root of the organization or another administrative group.

1. Onthe computer that hosts the Microsoft Exchange 2003 System Manager, open the Microsoft Exchange 2003
System Manager.

2. Configure the Exchange View Only Administrator permission for the Windows account in the administrative group that
contains the Microsoft Exchange 2003 servers that host BlackBerry device users.

3. Oneach Microsoft Exchange 2003 server that hosts BlackBerry device users, assign the following permissions to the
Windows account:

e SendAs
e Receive As
e Administer Information Store

4.  To permit the BlackBerry Enterprise Server to check if users have permissions to access a public folder, assign the
Owner permission for all public folders to the Windows account.

After you finish: Verify that the users have Read and Visible permissions to public folders.

Permit users to send email messages in a Microsoft
Exchange environment

To permit BlackBerry device users to send email messages, you must configure Send As permissions for the Microsoft
Active Directory user object that contains users. This task describes how to configure the Send As permissions for the
entire Windows domain, but you can also configure the permissions at the user object level or on a container of user
objects.

For more information about Send As permissions and the BlackBerry Enterprise Server, visit www.blackberry.com/btsc to
read article KB0O4707. For more information about assigning Send As permissions permissions to multiple user accounts,
visit support.microsoft.com to read article 912918.

1. Logintoacomputerinthe Windows domain as an administrator that has permissions to change user objects in
Microsoft Active Directory.

On the taskbar, click Start > Administrative Tools > Active Directory Users and Computers.
On the View menu, click Advanced Features.

Right-click the domain root. Click Properties.

On the Security tab, click Advanced.

Click Add.

Type the name of the Windows account that you created (for example, BESAdmin).

Click Check Names.

© N o o kK~ W D

38


http://www.blackberry.com/btsc
http://support.microsoft.com

Installation and Configuration Guide Preinstallation tasks

10.

11.
12.
13.

Click OK.

Perform one of the following actions:
e |fyou are running Windows Server 2003, in the Apply drop-down list, click User Objects.

e |fyouare running Windows Server 2008, in the Apply drop-down list, click Descendant User Objects.
In the Allow column, select the Send As check box.

Click Apply.

Click OK.

Configure permissions for the Windows
account

On each computer that you want to install the BlackBerry Enterprise Server components on, you must configure
permissions for the Windows account that you want to use to install the BlackBerry Enterprise Server components and run
the services for the BlackBerry Enterprise Server.

Without the correct permissions, the BlackBerry Enterprise Server cannot run.

o o A W o=
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10.
11.

12.

Right-click My Computer. Click Manage.

In the left pane, expand Local Users and Groups.
Navigate to the Groups folder.

In the right pane, double-click Administrators.
Click Add.

In the Enter the object names to select field, type the Windows account name that you want the services for the
BlackBerry Enterprise Server to use (for example, BESAdmin).

Click OK.

Click Apply.

Click OK.

On the taskbar, click Start > Programs > Administrative Tools > Local Security Policy.

Configure the following permissions for the Windows account:
e |ogon locally with local permissions (if not assigned by default)

e |ogon as aservice

On the taskbar, click Start > Programs > Administrative Tools > Computer Management.
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13. Add the Windows account to the local administrators group.

Prevent the Microsoft Exchange known
issues for wireless calendar synchronization

Some known issues for Microsoft Exchange impact how the BlackBerry Enterprise Server synchronizes calendars over the
wireless network. To prevent the known issues from occurring, you can read about the known issues for Microsoft
Exchange that might impact your organization's messaging environment and install the hotfixes for them. If your
organization's messaging environment includes multiple messaging servers, you can resolve the known issues that apply to
the latest Microsoft Exchange software version in your organization's environment.

If you do not install the correct hotfixes, the BlackBerry Enterprise Server cannot run.
1. Visit http://support.microsoft.com to read articles 823343 and 894470.

2. Verify that your organization's environment meets the requirements that are described in the applicable known
issues.

3.  Download the hotfixes for the known issues on the computers that you want to install the BlackBerry Enterprise
Server or BlackBerry Administration Service on.

4. Install the hotfixes.

Verify if the Windows account can access a
user account in Microsoft Exchange

The BlackBerry Enterprise Server requires permission to access each BlackBerry device user's mailbox to process email
messages. The IEMSText.exe tool runs a test to verify whether the Windows account has the Send As permission in
Microsoft Exchange so that the BlackBerry Enterprise Server can access user accounts. The IEMSText.exe tool does not
verify whether the BlackBerry Enterprise Server can send email messages on behalf of a BlackBerry device user.

1.  Copy the BlackBerry Enterprise Server installation files to the computer that you want to install the BlackBerry
Enterprise Server on.

2. Extract the contents to a folder on the computer.
3. Navigate to <extracted_folder>\Tools.

4.  Double-click IEMSTest.exe.
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In the Profile Name drop-down list, select the profile names for the user accounts.
Click OK.

In the left pane, select the user accounts that you want to check.

Click Select.

Click OK.

© ® N o O

Configuring connections for the BlackBerry
Enterprise Server database

The database for the BlackBerry Enterprise Server is the BlackBerry Configuration Database. You create the BlackBerry
Configuration Database when you install a BlackBerry Enterprise Server or BlackBerry Administration Service or when you
run the CreateDB executable.

The BlackBerry Enterprise Server can connect to its database on the Microsoft SQL Server using Windows authentication or
database authentication. By default, the BlackBerry Enterprise Server logs in to its database using the Windows account
that you use to complete the installation process or the database credentials you provided during the installation process.

To support database mirroring for the BlackBerry Configuration Database with Microsoft SQL Server 2005 or Microsoft SQL
Server 2008, you must use Windows authentication.

Specitying permissions when you connect to the
BlackBerry Configuration Database using Windows
authentication or Microsoft SQL Server authentication

If you connect the BlackBerry Enterprise Server to the BlackBerry Configuration Database using Windows authentication or
Microsoft SQL Server authentication during the BlackBerry Enterprise Server installation process, the Windows account or
Microsoft SQL Server account that you specify must have database permissions on the database server. The type of
permissions that you specify is determined by the setup option that you select and whether you create the BlackBerry
Configuration Database on the computer that hosts the BlackBerry Enterprise Server components or on another database
Server.
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Specifying permissions for the Windows account or Microsoft SQL Server
account

If you install Microsoft SQL Server 2008 R2 Express Edition during the BlackBerry Enterprise Server installation process,
you might need to specify permissions for the Windows account or Microsoft SQL Server account, depending on the type of
authentication you select.

When you select Windows authentication during the BlackBerry Enterprise Server installation process, the setup
application automatically assigns the required permissions to the Windows account that you use to complete the
installation process.

When you select Microsoft SQL Server authentication during the BlackBerry Enterprise Server installation process, you
must assign the required database permissions to the Microsoft SQL Server account that you use to complete the
installation process.

Assign permissions to the Windows account or Microsoft SQL Server
account

Perform one of the following actions:

e |fyou create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server and
you require the setup application to install Microsoft SQL Server Express during the installation process and you choose
Windows authentication, you are not required to assign Microsoft SQL Server permissions to the Windows account. If
you want the setup application to install the BlackBerry database notification system, you must assign the Microsoft
SQL Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL
Server Management Studio) to the Windows account.

e [fyou create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server and
you require the setup application to install Microsoft SQL Server Express during the installation process and you choose
Microsoft SQL Server authentication, you must assign the database creator (dbcreator server role) Microsoft SQL Server
permission to the Microsoft SQL Server account. If you want the setup application to install the BlackBerry database
notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also
called the sysadmin server role in Microsoft SQL Server Management Studio) to the Microsoft SQL Server account.

e |fyou create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server and
the computer already hosts a Microsoft SQL Server, you must assign the database creator (dbcreator server role)
Microsoft SQL Server permission to the Windows account or Microsoft SQL Server account that you use to complete the
BlackBerry Enterprise Server installation process. If you want the setup application to install the BlackBerry database
notification system, you must assign the Microsoft SQL Server permission for the database system administrator (also
called the sysadmin server role in Microsoft SQL Server Management Studio) to the Windows account or Microsoft SQL
Server account.

e [fyou create the BlackBerry Configuration Database on a computer that does not host the BlackBerry Enterprise
Server, you must assign the database creator (dbcreator server role) Microsoft SQL Server permission to the Windows
or Microsoft SQL Server account that you use to complete the BlackBerry Enterprise Server installation process. If you
want the setup application to install the BlackBerry database notification system, you must assign the Microsoft SQL
Server permission for the database system administrator (also called the sysadmin server role in Microsoft SQL Server
Management Studio) to the Windows account or Microsoft SQL Server account.
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Create a BlackBerry Configuration Database

If the

security required by your organization does not allow applications to have permissions to create or upgrade

databases, you can run the CreateDB executable on the database server to create the BlackBerry Configuration Database
instead of using the setup application. After you create or upgrade the BlackBerry Configuration Database using the

Creat

eDB executable, you can run the setup application using a Windows account with minimum requirements to the

database server.

Before you begin: Verify that the appropriate permissions are configured on the database server.

1.
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10.

Log in to the computer that hosts the database server using a local administrator account or a Windows account that
has SQL administrator permissions.

Copy the BlackBerry Enterprise Server installation files to the database server that you want to configure as the host
server for the BlackBerry Configuration Database.

Extract the contents to a folder on the computer.

Navigate to <extracted_folder>\Database.

Open the BesMgmt.cfg file in a text editor.

Change the file to include information that is specific to your organization's environment.
Save and close the file.

Open a command prompt window.

Change to <extracted_folder>\Database.

Type CreateDB.exe BESMgmt.cfg.

BESMgmt.cfg properties

Property Description

CMD This property specifies the type of action that the CreateDB executable must complete (for
example, whether to install or upgrade the BlackBerry Configuration Database).

DATABASE_NAME This property specifies the name of the BlackBerry Configuration Database.

SERVER This property specifies the name of the database server that hosts the BlackBerry
Configuration Database. If a database instance hosts the BlackBerry Configuration
Database, follow the format database_server_name\database_instance_name.

USERID If you use database authentication, this property specifies the user name of the database

account that has server administrator permission and database creator permission.
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Property Description

PASSWORD If you use database authentication, this property specifies the password for the database
account.

SCRIPT_ROOT This property specifies the path to the DBInstallScripts folder.

By default, this folder is in the same root folder that the CreateDB.exe file is located in.

LOG_DIR This property specifies the path to the folder that you want to create log files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located in.
DBMS This property specifies the database management system that your organization uses.

DB_FILE_DIR This property specifies an existing folder that you want to save the database files in.

By default, this folder is in the same root folder that the CreateDB.exe file is located in.

BACKUP_DIR This property specifies an existing folder where you want to save the database backup in.
By default, this folder is located in the same root folder that the CreateDB.exe file is located
in.

BES_TYPE This property specifies the messaging server that your organization uses.

Install the SNMP service for monitoring by a
monitoring application

You must install the SNMP service on each computer that you want to install the BlackBerry Enterprise Server if you want
to use a monitoring application to monitor the BlackBerry Enterprise Server activity.

Before you begin: Verify that each computer can access the Windows installation media.

1. Onthetaskbar, click Start > Settings > Control Panel > Add/Remove Programs > Add/Remove Windows
Components.

Double-click Management and Monitoring Tools.
Select the Simple Network Management Protocol check box.
Click OK.

When Windows Setup prompts you, install the files from the Windows installation media.

o o~ WD

Complete the installation wizard.
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7. Inthe Windows Services, verify that the SNMP service is running.

After you finish: To complete the SNMP service installation process, after you install the BlackBerry Enterprise Server or
BlackBerry Enterprise Server components, configure the SNMP service to monitor the activity of the BlackBerry Enterprise
Server or BlackBerry Enterprise Server components.

Creating a BlackBerry Administration
Service pool that includes the BlackBerry
Web Desktop Manager using DNS round
robin

When you install the BlackBerry Administration Service, BlackBerry Web Desktop Manager, or both, the setup application
installs the BlackBerry Administration Service services automatically. The BlackBerry Administration Service and
BlackBerry Web Desktop Manager require the BlackBerry Administration Service services to run.

If you create a BlackBerry Administration Service pool using DNS round robin, you can install the BlackBerry
Administration Service and BlackBerry Web Desktop Manager on each computer in the pool or you can install the
BlackBerry Administration Service or BlackBerry Web Desktop Manager on some of the computers in the pool. If you install
the BlackBerry Administration Service and BlackBerry Web Desktop Manager on each computer in the pool, you can use
the pool name that you specified during the installation process in the URLSs for the BlackBerry Administration Service and
BlackBerry Web Desktop Manager (for example, https://<pool_name>/webconsole/login or https://<pool_name>/
webdesktop/login).

If you do not install both components on each computer in the pool and you try to access one of the URLs using the pool
name, the web browser might display an HTTP 404 error message. The HTTP 404 error message occurs when the web
browser tries to connect to a computer in the pool that you did not install the component on that you are trying to access.
For example, you can install the BlackBerry Administration Service on two of the computers in the pool and the BlackBerry
Web Desktop Manager on two other computers in the pool.

To make sure that the web browser does not display HTTP 404 error messages, you can choose one of the following
options:

e You can create separate pools within the BlackBerry Administration Service pool for the BlackBerry Administration
Service and the BlackBerry Web Desktop Manager. You can provide your organization's administrators and BlackBerry
device users with URLs that include the specific pool names.

e You can provide administrators and users in your organization's environment with URLs that include the FQDNs of the
computers that you installed the BlackBerry Administration Service or BlackBerry Web Desktop Manager on (for
example, https://<FQDN_of_computer>/webconsole/login or https://<FQDN_of_computer>/webdesktop/login).
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Create the DNS record for a BlackBerry
Administration Service instance

To configure multiple BlackBerry Administration Service instances for high availability using DNS round robin, you must
create a DNS record. The DNS record permits the clients of the BlackBerry Administration Service pool to access the
instances using a single DNS name. You must create the DNS record in the same domain as the computers that host the
BlackBerry Administration Service instances.

Before you begin:
e Configure a static IP address for each computer that you want to install a BlackBerry Administration Service instance
on.

e (Obtain permission to manage the DNS.

e [fyou configure DNS round robin, configure clients to resolve the DNS name into a list of IP addresses and distribute
traffic equally across the BlackBerry Administration Service instances in the pool.

1. Logintothe DNS server.

2. Inthe DNS management console, access the forward lookup zone that you want to add the BlackBerry
Administration Service instance to.

3.  Tocreate a new host, perform the following actions:

1. Inthe Name field, type the name of the BlackBerry Administration Service pool that you want to use.

2. Inthe IP Addressl field, type the IP address of the computer that you want to host a BlackBerry Administration
Service instance on.

3. Select the Create associated pointer (PTR) record check box.

4.  Repeat step 3 for each BlackBerry Administration Service instance that you want to install. When you add entries to
the same pool, you must use the same pool name for all BlackBerry Administration Service instances.

After you finish: To remove a BlackBerry Administration Service instance from a pool, delete the entry for the IP address of
the BlackBerry Administration Service instance from the DNS server.
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Preparing the computer that hosts the
BlackBerry Collaboration Service for use
with Microsoft Office Communications
Server 2007 R2

If you plan to install the BlackBerry Collaboration Service for use with Microsoft Office Communications Server 2007 R2,
you must verify that the computer that you install the BlackBerry Collaboration Service on includes the required items.

Before you install the BlackBerry Collaboration Service, you must perform the following actions in the order that they are
listed below:

1. Install and enable Microsoft .NET Framework 3.5 SP1 (if you installed Microsoft .NET Framework 4.0, visit
support.microsoft.com to read article 2224981 before you continue).

2. For the following steps, use the install packages included with the Microsoft Office Communications Server 2007 R2
installation files. For steps a and b, you can find the files in Setup\amd64, and for steps ¢ and d, you can find the files in
Setup\amd64\Setup.

a Install Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe).

b Install Microsoft SQL Server Native Client (sqIncli_x64.msi).

¢ Install Microsoft Unified Communications Managed API 2.0 Core Redist 64-bit (ucmaredist.msi).
d Install Microsoft Office Communications Server 2007 R2, Core Components (ocscore.msi).

3. |Install the required certificate in the Personal Certificate folder for the local computer account. You must choose the
Web Server Certificate template and specify the following information:

e Forthe Subject Name, type the FQDN of the computer that you install the BlackBerry Collaboration Service on.
e Forthe Friendly Name, type OCSConnector.

To download the install packages, visit the Microsoft Download Center or the Volume Licensing Service Center at
www.microsoft.com.

For more information about installing the required certificate, visit www.blackberry.com/btsc to read article KB24960.
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Preparing the computer that hosts the
BlackBerry Collaboration Service for use
with Microsoft Lync Server 2010

If you plan to install the BlackBerry Collaboration Service for use with Microsoft Lync Server 2010, you must verify that the
computer that you install the BlackBerry Collaboration Service on includes the required items.

Before you install the BlackBerry Collaboration Service, you must perform the following actions in the order that they are
listed below:

1. Install and enable Microsoft .NET Framework 3.5 SP1 (if you installed Microsoft .NET Framework 4.0, visit
support.microsoft.com to read article 2224981 before you continue).

2. For the following steps, use the install packages included with Microsoft Lync Server 2010 installation files. You can
find the files in Setup\amd64.

a Install Microsoft Visual C++ 2008 Redistributable Package (vcredist_x64.exe).
b Install Microsoft SQL Server Native Client (sqglncli_x64.msi).

3. Forthe following steps, you need to download the software from the Volume Licensing Service Center at
www.microsoft.com.

a Install Microsoft Unified Communications Managed API 2.0 Core Redist 64-bit (ucmaredist.msi).
b Install Microsoft Office Communications Server 2007 R2, Core Components (ocscore.msi).

4. |Install the required certificate in the Personal Certificate folder for the local computer account. You must choose the
Web Server Certificate template and specify the following information:

e Forthe Subject Name, type the FQDN of the Microsoft Lync Server 2010 pool.

e Forthe Subject Alternative Names, type the FQDN of the Microsoft Lync Server 2010 pool and the FQDN of the
computer that you install the BlackBerry Collaboration Service on.

e Forthe Friendly Name, type OCSConnector.

The BlackBerry Collaboration Service supports Microsoft Unified Communications Managed API 2.0 and must use
Microsoft Office Communications Server 2007 R2, Core Components to take advantage of the backwards compatibility of
Microsoft Lync Server 2010 with Microsoft Unified Communications Managed API 2.0. The BlackBerry Collaboration
Service does not support using ocscore.msi or ucmaredist.msi from the Microsoft Lync Server 2010 installation files.

To download the install packages, visit the Microsoft Download Center or the Volume Licensing Service Center at
www.microsoft.com.

For more information about installing the required certificate, visit www.blackberry.com/btsc to read article KB24960.
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Persistent socket connections for the
BlackBerry Collaboration Service

Instant messaging environment

Microsoft Office Live Communications Server 2005 or
Microsoft Office Communications Server 2007, and TLS
communication protocol

Microsoft Office Live Communications Server 2005 or
Microsoft Office Communications Server 2007, and TCP
communication protocol

Microsoft Office Live Communications Server 2005 or
Microsoft Office Communications Server 2007, and HTTPS
communication protocol

IBM Sametime

Novell GroupWise Messenger

BlackBerry Collaboration Service requirements

one persistent socket connection for each instant
messaging session

three persistent socket connections for each instant
messaging session

one persistent socket connection and multiple sequential
socket connections for each instant messaging session

three persistent socket connections to create one TCP
connection; all instant messaging sessions use that TCP
connection

one persistent socket connection for each instant
messaging session

Microsoft Office Communications Server 2007 R2 and Microsoft Lync Server 2010 do not require any persistent socket
connections, you can use a small pool of shared connections for instant messaging sessions instead.

Applications that are installed with the
BlackBerry Enterprise Server components

You can use the BlackBerry Enterprise Server installation process to install third-party applications.
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Application BlackBerry Enterprise Server components that the application is
installed with
JDK 1.6.x BlackBerry Enterprise Server (core)
BlackBerry Administration Service
JRE 1.6.x

Microsoft XML Core Services 6.0 SP2

Microsoft SQL Server 2008 R2 Express Edition
(if selected)

Microsoft .NET Framework 2.0

(if you are installing Microsoft SQL Server
Express)

Microsoft .NET Framework 3.5 SP1

(if you are installing Microsoft Office
Communications Server 2007 R2 or Microsoft
Lync Server 2010)
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Installing the BlackBerry 6
Enterprise Server software

Prerequisites: Installing the BlackBerry
Enterprise Server software

e Verify that the Windows account that you use to install the BlackBerry Enterprise Server software is assigned the local
administrator permission on the computer that you perform the installation process on.

e Verify that the Windows account that you want to use to install the BlackBerry Enterprise Server software is not a
member of the Domain Admins group in Microsoft Active Directory.

e |na Microsoft Exchange 2003 environment, to start the MAPI subsystem, open the Microsoft Exchange System
Manager.

e InaWindows Server 2003 environment, to install Microsoft SQL Server 2008 R2 Express Edition during the installation
of BlackBerry Enterprise Server, you must install Windows PowerShell 1.0, Microsoft .NET Framework 3.5 SP1, and
Microsoft Windows Installer 4.5 before you run the BlackBerry Enterprise Server setup application.

e |fyour organization's domain controllers are running on Windows Server 2008, verify that the number of NSPI
connections that the BlackBerry Enterprise Server can make to the Microsoft Exchange Server meets the requirements
of your organization. For more information, visit www.blackberry.com/btsc to read article KB17325 and visit
support.microsoft.com to read article 949469.

e Retrieve the following information:

e BlackBerry CAL key

e SRP host (in BlackBerry Enterprise Server version 5.0 and later, the format of the SRP host is different from earlier
versions)

e SRPidentifier
e SRP authentication key

e computer name and port number of the instant messaging server (For Microsoft Office Live Communications Server
2005 and Microsoft Office Communications Server 2007 use the virtual server name and port number where the
AJAX service is installed.)
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e computer name and port number of the proxy server (if applicable)

Add the blackberry.net domain to the permitted lists in the antivirus application or anti-spam application that the
messaging server or gateway uses.

Verify that the computer has access to www.blackberry.com (optional).
If your organization uses a proxy server for Internet access, get the credentials for the proxy server.

Verify that you installed the appropriate languages and text services on the computer that you use to install the
BlackBerry Enterprise Server, including code page 20127 (US-ASCII) which is required for all supported languages.

If you want to install Microsoft SQL Server 2008 R2 Express Edition on a computer that does not host any BlackBerry
Enterprise Server components, you can navigate to the Tools folder in the BlackBerry Enterprise Server installation files
and run Sglexpr.exe.

If you are installing the BlackBerry Administration Service, verify that the computers that host the BlackBerry
Administration Service and BlackBerry Configuration Database are not separated by a WAN bridge.

If you are performing the installation on a computer that has more than one NIC, verify that the production NIC is first in
the bind order in the Windows network settings.

Install the BlackBerry Enterprise Server
software

Note: To manage the BlackBerry Enterprise Server, you must install the BlackBerry Administration Service. You can install
the BlackBerry Administration Service on the computer that hosts the BlackBerry Enterprise Server or on a separate
computer. You must install the BlackBerry Administration Service if you create a BlackBerry Configuration Database and
you must also either install or upgrade the BlackBerry Administration Service on the computer that you perform the
installation process on in the BlackBerry Enterprise Server domain.

1.
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Log in to the computer that you want to install the BlackBerry Enterprise Server on using the Windows account that
you created and that has correct permissions. This account runs the BlackBerry Enterprise Server services.

In the BlackBerry Enterprise Server installation files, double-click setup.exe. If your operating system is Windows
Server 2008, run setup.exe as an administrator.

In the Setup type dialog box, select one of the following options:
e |[fthisinstallation process is the first installation of BlackBerry Enterprise Server software in a BlackBerry
Enterprise Server domain, select Create a BlackBerry Configuration Database.

e Forall other installations of the BlackBerry Enterprise Server software, select Use an existing BlackBerry
Configuration Database.

In the Setup options dialog box, you can select or remove BlackBerry Enterprise Server components from the
Additional Components list.
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10.

11.

12.

In the Accounts and Folders dialog box, in the Name field, type the name of the BlackBerry Enterprise Server that
you want the BlackBerry Administration Service to display.

After the setup application installs the necessary components, click Continue.

In the Database information dialog box, if you configured the database server to use static ports, select the Static
option. If the static port number is not 1433, in the Port field, type the port number.

In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for
database mirroring check box and in the Name of the mirror database server field, type the name of the database
server that hosts the mirror database. The setup application does not create the BlackBerry Configuration Database
on the mirror Microsoft SQL Server; it adds a registry key to the computer that includes the name of the mirror
Microsoft SQL Server.

In the MAPI Settings dialog box, perform the following actions:
a. Inthe Microsoft Exchange server field, type the name of the Microsoft Exchange server.

b.  Inthe Mailbox field, type the name of the administrator that has the appropriate permissions.
c.  Click Check Name.
d. Click OK.

In the Administration settings dialog box, perform the following actions:

¢ |nthe Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration
Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry
Enterprise Server domain, you can accept the default pool name. If you install more than one BlackBerry
Administration Service instance in the BlackBerry Enterprise Server domain, you must create a DNS entry for the
pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration
Service instance.

¢ |nthe New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry
Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry
Administration Service instance in the BlackBerry Enterprise Server domain.

In the Microsoft® Active Directory® settings dialog box, in the User password field, type the password for the
Microsoft Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to
authenticate with Microsoft Active Directory. If you want to specify a different username and Windows domain, you
must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft
Exchange organization.

In the Advanced administration settings dialog box, perform one of the following actions:
e |fyou select Use Windows authentication, you can choose to use the Microsoft Active Directory account that you
used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.

e |fyou select Use BlackBerry Administration Service authentication, type and confirm a password for the
BlackBerry Administration Service administrator account. Consider using the minimum rules for password
complexity when you create the password for the administrator account. The password should be at least 8
characters in length and contain at least one number, letter, and special character, and should not contain
dictionary words.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.
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13. Start the services for the BlackBerry Enterprise Server. If you installed the BlackBerry Administration Service, the
setup application waits until the BlackBerry Administration Service services are running before the setup application
continues.

14. Inthe Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and
paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry
Enterprise Server components that you installed.

After you finish:
e To verify that the BlackBerry Configuration Database on a Microsoft SQL Server uses the appropriate collation setting,
check that the collation setting for the BlackBerry Configuration Database is default case-insensitive.

e |fyou reinstalled the BlackBerry Administration Service, in, delete the cache.

Specifying a name for the BlackBerry Administration
Service pool during the installation process

During the installation process, the setup application prompts you to specify the name of the BlackBerry Administration
Service pool.

The BlackBerry Administration Service instances use the pool name for interprocess communication and when you
configure BlackBerry Administration Service high availability using DNS round robin. You must specify a valid DNS host
name during the installation process, even if you do not configure BlackBerry Administration Service high availability using
DNS round robin.

The setup application uses the FQDN of the computer that you install the first BlackBerry Administration Service instance
on as the default value for the pool name. If you keep the default value and configure BlackBerry Administration Service
high availability using DNS round robin at a later time, you must use the BlackBerry Configuration Panel to change the pool
name to the host name for the pool.

The name for the BlackBerry Administration Service pool does not impact BlackBerry Administration Service high
availability that uses a hardware load balancer.

For more information about BlackBerry Administration Service high availability, see the BlackBerry Enterprise Server
Planning Guide.
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Install a BlackBerry Enterprise Server
component on a computer that is separate
from the computer that hosts the
BlackBerry Enterprise Server

Before you begin:
e |nstall a BlackBerry Enterprise Server and the BlackBerry Administration Service in your organization's environment.

e \Verify that the BlackBerry Administration Service is running on a Windows account that has permission to access and
change the Windows registry on the computer that you want to install the BlackBerry Enterprise Server component on.

e |fyou configured database mirroring for the BlackBerry Configuration Database, you must verify that the BlackBerry
Enterprise Server is connected to the principal database before you run the setup application.

1.  Using the Windows account that you created, log in to the computer that is separate from the computer that hosts the
BlackBerry Enterprise Server. This account runs the services for the BlackBerry Enterprise Server components.

2. Inthe BlackBerry Enterprise Server installation files, double-click setup.exe. If the computer is running Windows
Server 2008, run setup.exe as an administrator.

3. Inthe Setup type dialog box, select Use an existing BlackBerry Configuration Database.

4.  Inthe Database information dialog box, perform the following actions:

e Type the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise
Server uses.

e |fyou configured the database server to use static ports, select the Static option. If the static port number is not
1433, in the Port field, type the port number.

5. Inthe Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for
database mirroring check box and type the name of the database server that hosts the mirror database in the Name
of the mirror database server field. The setup application does not create the BlackBerry Configuration Database on
the mirror Microsoft SQL Server; it adds a registry key to the computer that contains the name of the mirror Microsoft
SQL Server.

6. Inthe Setup options dialog box, select or remove BlackBerry Enterprise Server components from the Additional
Components list.

7. Inthe MAPI Settings dialog box, perform the following actions:
a. Inthe Microsoft Exchange server field, type the name of the Microsoft Exchange server.

b.  Inthe Mailbox field, type the name of the administrator that is assigned the appropriate permissions.
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10.

11.

12.
13.

C. Click Check Name.
d. Click OK.

After the setup application installs the necessary components, click Continue.

In the Administration settings dialog box, perform the following actions:

e |nthe Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration
Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry
Enterprise Server domain, you can accept the default pool name. If you install more than one BlackBerry
Administration Service instance in the BlackBerry Enterprise Server domain, you must create a DNS entry for the
pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration
Service instance.

¢ |nthe New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry
Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry
Administration Service instance in the BlackBerry Enterprise Server domain.

In the Microsoft Active Directory settings dialog box, in the User password field, type the password for the Microsoft
Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server uses to authenticate with
Microsoft Active Directory. If you want to specify a different username and Windows domain, make sure that the
Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft Exchange organization.

In the Advanced administration settings dialog box, perform one of the following actions:

e [fyou select Use Windows authentication, you can choose to use the Microsoft Active Directory account that you
used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.

e |fyou select Use BlackBerry Administration Service authentication, type and confirm a password for the
BlackBerry Administration Service administrator account. Consider using the minimum rules for password
complexity when you create the password for the administrator account. The password should be at least 8
characters in length and contain at least one number, letter, and special character, and should not contain
dictionary words.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.
In the Start services dialog box, start the services for the BlackBerry Enterprise Server components.

In the Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and
paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry
Enterprise Server components.

After you finish:
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If you reinstalled the BlackBerry Administration Service, in, delete the cache.



Installation and Configuration Guide Installing the BlackBerry Enterprise Server software

Install a standalone BlackBerry Router

A standalone BlackBerry Router is a BlackBerry Router that is hosted by a computer that does not host any other
BlackBerry Enterprise Server components except the BlackBerry Controller. The BlackBerry Controller monitors the
BlackBerry Router and restarts the BlackBerry Router if it stops responding.

Note: You cannot manage the BlackBerry Controller that monitors a standalone BlackBerry Router in the BlackBerry
Administration Service. You must manage the BlackBerry Controller in the BlackBerry Configuration Panel on the
computer that hosts the standalone BlackBerry Router.

1. Login to the computer using the Windows account that you want to use to run the BlackBerry Router.

2. Inthe BlackBerry Enterprise Server installation files, double-click Setup.exe. If your operating system is Windows
Server 2008, run setup.exe as an administrator.

3. Inthe Setup type dialog box, select Install a standalone BlackBerry Router.

4. When you receive a prompt, do not start the BlackBerry Router service until you configure the BlackBerry Router to
connect to the BlackBerry Enterprise Server.

Test the connection from the BlackBerry Router to the
BlackBerry Infrastructure

To make sure that the BlackBerry Router can connect to the BlackBerry Infrastructure, you can test the connection using
the BBSRPTest tool that is included with the BlackBerry Enterprise Server installation files. The BBSRPTest tool tries to
connect to the BlackBerry Infrastructure using the SRP address and SRP port that you specified for the BlackBerry
Infrastructure during the BlackBerry Router installation process.

1.  Onthe computer that you want to test the connection to the BlackBerry Infrastructure on, at a command prompt,
navigate to <drive>:\Program Files\Research In Motion\BlackBerry Enterprise Server.

2. Type bbsrptest <srp_address> -<port>, where <srp_address> is the SRP address that you provided during the
installation process and <port> is the SRP port number. For example, at the command line, type bbsrptest.exe —host
serverl.example.com —port 3101.

After you finish: If the test does not complete, use the Windows Socket (WINSOCK) error code to diagnose the problem.
For more information, visit http://msdn.microsoft.com to read article Windows Socket Error Codes.
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Installing a standby BlackBerry
Enterprise Server

To configure the BlackBerry Enterprise Server for high availability and disaster recovery, you install a standby BlackBerry
Enterprise Server on a separate computer from your organization's primary BlackBerry Enterprise Server. During the
installation process, you assign a standby BlackBerry Enterprise Server to a primary BlackBerry Enterprise Server. You can
assign only one standby BlackBerry Enterprise Server to each primary BlackBerry Enterprise Server. The setup application
assigns the SRP credentials of the primary BlackBerry Enterprise Server to the standby BlackBerry Enterprise Server
automatically.

When you install a standby BlackBerry Enterprise Server, you can install the same BlackBerry Enterprise Server
components that are installed on the primary BlackBerry Enterprise Server, or different components. For example, you
might want to install additional components with the standby BlackBerry Enterprise Server if you want to use the system
resources on the computer to distribute the performance load.

You cannot change a primary BlackBerry Enterprise Server to a standby BlackBerry Enterprise Server by running the setup
application again.

By default, the standby BlackBerry Enterprise Server enables you to fail over the following components if they stop
responding on the primary BlackBerry Enterprise Server:

e BlackBerry Attachment Service

e BlackBerry Collaboration Service

e BlackBerry Dispatcher

e BlackBerry MDS Connection Service

e BlackBerry Messaging Agent

e BlackBerry Policy Service

e BlackBerry Router

e BlackBerry Synchronization Service

After you complete the installation process, the setup application does not start all the services for the standby BlackBerry
Enterprise Server components. For example, the setup application does not start the BlackBerry Mail Store Service,

BlackBerry Synchronization Service, or BlackBerry Policy Service. The failover process starts the services when the
standby BlackBerry Enterprise Server promotes itself.

For more information about high availability in a large-scale environment, see the BlackBerry Enterprise Server Planning
Guide.
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Install a standby BlackBerry Enterprise
Server

Before you begin:

Install a primary BlackBerry Enterprise Server.

If you configured database mirroring for the BlackBerry Configuration Database, you must verify that the primary
BlackBerry Enterprise Server is connected to the principal database before you run the setup application.

Verify that the BlackBerry Administration Service is running on a Windows account that has permission to access and

change the Windows registry on the computer that you want to install the standby BlackBerry Enterprise Server on.
Log in to the computer using the Windows account that you used to install the primary BlackBerry Enterprise Server.
This account runs the services for the standby BlackBerry Enterprise Server.

In the BlackBerry Enterprise Server installation files, double-click setup.exe. If the computer is running Windows
Server 2008, run setup.exe as an administrator.

In the Setup type dialog box, select Use an existing BlackBerry Configuration Database.

In the Database information dialog box, perform the following actions:

e Type the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise
Server uses.

e |fyou configured the database server to use static ports, select the Static option. If the static port number is not
1433, type the port number in the Port field.

In the Database mirroring options dialog box, if you want to configure database mirroring, select the Add support for
database mirroring check box and type the name of the database server that hosts the mirror database in the Name

of the mirror database server field. The setup application does not create the BlackBerry Configuration Database on
the mirror Microsoft SQL Server, it adds a registry key to the computer that includes the name of the mirror Microsoft

SQL Server.

In the MAPI Settings dialog box, perform the following actions:
a. Inthe Microsoft Exchange server field, type the name of the Microsoft Exchange server.

b.  Inthe Mailbox field, type the name of the administrator that has the appropriate permissions.
c. Click Check Name.
d. Click OK.

In the Setup options dialog box, perform the following actions:
e (lick Install a standby BlackBerry Enterprise Server to set up high availability.
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e |nthe Additional components list, select any components that you want to install with the standby BlackBerry
Enterprise Server.

8. Inthe High availability settings dialog box, select the primary BlackBerry Enterprise Server that you want to assign
the standby BlackBerry Enterprise Server to.

9.  After the setup application installs the necessary components, click Continue.

10. Inthe Administration settings dialog box, perform the following actions:

¢ Inthe Pool name field, type an FQDN that the setup application can use to create the BlackBerry Administration
Service web address. If you install only one BlackBerry Administration Service instance in the BlackBerry
Enterprise Server domain, you can accept the default pool name. If you install more than one BlackBerry
Administration Service instance in the BlackBerry Enterprise Server domain, you must create a DNS entry for the
pool name that is not the name of a computer and is mapped to the IP address of each BlackBerry Administration
Service instance.

e |nthe New password and Confirm password fields, type the password for the SSL certificate that the BlackBerry
Administration Service uses to authenticate with browsers. You must use the same password for every BlackBerry
Administration Service instance in the BlackBerry Enterprise Server domain.

11. Inthe Microsoft Active Directory settings dialog box, in the User password field, type the password for the Microsoft
Active Directory account (for example, BESAdmin) that the standby BlackBerry Enterprise Server uses to
authenticate with Microsoft Active Directory. If you want to specify a different username and Windows domain, you
must make sure that the Windows domain belongs to the same Microsoft Active Directory forest as the Microsoft
Exchange organization.

12. Inthe Advanced administration settings dialog box, perform one of the following actions:
e |fyou select Use Windows authentication, you can choose to use the Microsoft Active Directory account that you
used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.

e [fyou select Use BlackBerry Administration Service authentication, type and confirm a password for the
BlackBerry Administration Service administrator account. Consider using the minimum rules for password
complexity when you create the password for the administrator account. The password should be at least 8
characters in length and contain at least one number, letter, and special character, and should not contain
dictionary words.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.

13. Start the services for the standby BlackBerry Enterprise Server.

14. Inthe Console addresses dialog box, copy the BlackBerry Administration Service web address and paste it into a
document for future reference. You can use the web address to log in to the BlackBerry Administration Service.

After you finish:
e Toview the standby BlackBerry Enterprise Server information in the BlackBerry Administration Service, restart the
BlackBerry Administration Service on every computer that it is installed on in the BlackBerry Enterprise Server domain.

e |fyou reinstalled the BlackBerry Administration Service, in, delete the cache contents.
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Postinstallation tasks _

Test the BlackBerry Enterprise Server
Installation

1.  Inthe Windows Services, verify that the services for the BlackBerry Enterprise Server are running.

2. Inthe Windows Event Viewer and log files that are located in <drive>:\Program Files\Research In Motion\BlackBerry
Enterprise Server\Logs, check for error messages.

3. Inthe BlackBerry Administration Service, add a test user account.
If you can add a test user account, the connection from the BlackBerry Enterprise Server to the BlackBerry
Configuration Database and the messaging server is open.

4.  Ifyouinstalled the BlackBerry MDS Connection Service, browse to http://<BES_host>:8080.
If the status page appears, the BlackBerry MDS Connection Service is running.

After you finish: For troubleshooting information, visit www.blackberry.com/support.

Install the BlackBerry database notification
system

The BlackBerry database notification system is a publish/subscribe system that is designed to reduce the number of
database queries that a BlackBerry Enterprise Server makes to the BlackBerry Configuration Database.

If you create the BlackBerry Configuration Database on the computer that hosts the BlackBerry Enterprise Server, the
BlackBerry database notification system installs automatically.

If you create the BlackBerry Configuration Database on a database server that you installed on a computer that is not the
computer that hosts the BlackBerry Enterprise Server, you can install the BlackBerry database notification system
manually after you complete the BlackBerry Enterprise Server installation process.

Before you begin:
e You must have the system administrator permission for the database.
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11.

On the database server, open the BlackBerry Enterprise Server installation files.

Perform one of the following actions:

e |fa32-bit Microsoft SQL Server is running in your organization's environment, in the Tools\DBNS\x86 folder, copy
the RimEsp.dll file to C:\Program Files\Microsoft SQL Server\MSSQL\Binn.

e |fa64-bit Microsoft SQL Server is running in your organization's environment, in the Tools\DBNS\x64 folder, copy
the RimEsp.dll file to C:\Program Files(x86)\Microsoft SQL Server\MSSQL\Binn.

Open the Microsoft SQL Server Management Studio.

Using the Microsoft SQL Server Management Studio, navigate to Database\DBInstallScripts\SQLServer\5.0 in the
BlackBerry Enterprise Server installation files.

Open the NotifyMasterinstall.sql file.

Run the script.

Open the Notifylnstall.sql file.

Change <_DATABASENAME_ > to the name of the BlackBerry Configuration Database (for example, BesMgmt).
Run the script.

Confirm that the Microsoft SQL Server Management Studio displays the Function dbo.xp_RIMxxxx registered
message.

To add additional BlackBerry Configuration Database instances in your organization's environment, repeat steps 7 to
10.

Best practice: Running the BlackBerry
Enterprise Server

Best practice Description

Do not change the startup type forthe  When you install or upgrade the BlackBerry Enterprise Server, the setup
BlackBerry Enterprise Server services.  application configures the startup type for the BlackBerry Enterprise Server

services to automatic or manual. For example, the setup application configures
the startup type for the BlackBerry Mail Store Service, BlackBerry Policy
Service, and BlackBerry Synchronization Service to manual.

To avoid errors in the BlackBerry Enterprise Server, do not change the startup
type for the BlackBerry Enterprise Server services.

Do not change the account information When you install or upgrade the BlackBerry Enterprise Server, the setup
for BlackBerry Enterprise Server application configures the account information for the BlackBerry Enterprise
services. Server services.
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Best practice Description

Do not change the account information for the BlackBerry Enterprise Server
unless the BlackBerry Enterprise Server documentation specifies that you can.

Run the BlackBerry Configuration Consider the following guidelines if you are running the BlackBerry Configuration
Panel as an administrator. Panel on Windows Server 2008:

e | ogintothe computer with a user account that is in the Administrator group
on the Windows Server.

e Right-click the BlackBerry Configuration Panel icon and click Run as
administrator.

Configuring support for Unicode languages

Configure support for Unicode languages

You can make sure that the messaging application can display the Unicode messages that the BlackBerry device sends by
configuring the BlackBerry Enterprise Server to support Unicode languages (for example, Japanese, Korean, or Simplified
Chinese).

1.

2
3.
4

On the computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.
Type regedit.
Click OK.

Perform one of the following actions:

e |fyou are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion
\BlackBerry Enterprise Server\Agents.

e [fyou are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINEASOFTWARE\WOW6432Node
\Research In Motion\BlackBerry Enterprise Server\Agents.

If the MAPIEncoding registry key exists, perform one of the following actions:
e Delete the key.

e (Change the value of the key to 1.

Perform one of the following actions:

e |fyou are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion
\BlackBerry Enterprise Serven\Setup.
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e [fyou are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node
\Research In Motion\BlackBerry Enterprise Serven\Setup.

7. Verify that the ConfigKeystoreCountry registry key is set to one of the following values, depending on your
organization's environment:

e CN for Simplified Chinese
e JPforJapanese
e KR for Korean

8. Inthe Windows Services, restart the BlackBerry Dispatcher.

Change the character encoding that the BlackBerry
Enterprise Server uses to send Unicode messages

By default, when the BlackBerry Enterprise Server receives Unicode messages from BlackBerry devices, it uses UTF-8
character encoding to process the Unicode messages. If email applications cannot correctly display Unicode messages
that devices send (for example, if email applications cannot display attachment file names or contact lists correctly), you
can configure the BlackBerry Enterprise Server to select another character encoding to use to process Unicode messages.

Before you begin: Configure support for Unicode languages.

1.  Onthe computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.
2 Type regedit.
3. Click OK.
4

Perform one of the following actions:

e [fyou are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion
\BlackBerry Enterprise Server\Agents.

e [fyou are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node
\Research In Motion\BlackBerry Enterprise Server\Agents.

5. Create a DWORD value that is named AutoSelectOutgoingEncoding.
6.  Double-click the new DWORD value.

7. Inthe Value data field, perform one of the following actions:

e To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes
plain-text messages, type 1. If the BlackBerry Enterprise Server cannot identify which character encoding to use,
the BlackBerry Enterprise Server encodes plain-text messages in UTF-8.

e To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes
email messages that use RTF or HTML, type 2. If the BlackBerry Enterprise Server cannot identify which
character encoding to use, the BlackBerry Enterprise Server encodes email messages that use RTF or HTML in
UTF-8.
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e To configure the BlackBerry Enterprise Server to select the most appropriate character encoding when it encodes
plain-text messages and email messages that use RTF or HTML, type 3. If the BlackBerry Enterprise Server
cannot identify which character encoding to use, the BlackBerry Enterprise Server encodes all email messages in
UTF-8.

8. Inthe Windows Services, restart the BlackBerry Dispatcher.

Configure the BlackBerry Enterprise Server to use only
UTF-8 to send Unicode messages

To make sure that the BlackBerry Enterprise Server uses only UTF-8 character encoding to process Unicode messages
that it receives from BlackBerry devices, complete the following steps.

1. Onthe computer that hosts the BlackBerry Enterprise Server, on the taskbar, click Start > Run.
2 Type regedit.
3. Click OK.
4

Perform one of the following actions:

e |fyou are running a 32-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion
\BlackBerry Enterprise Server\Agents.

e Ifyou are running a 64-bit version of Windows, go to HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node
\Research In Motion\BlackBerry Enterprise Server\Agents.

Create a DWORD value that is named MAPIEncoding.

In the Value data field, type 0 and click OK.

Create a DWORD value that is named AutoSelectOutgoingEncoding.
In the Value data field, type 0 and click OK.
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In the Windows Services, restart the BlackBerry Dispatcher.

Configure support for Unicode text in calendars on
BlackBerry devices in a Microsoft Exchange
environment

Before you begin: In a Microsoft Exchange 2003 environment, install the following hotfixes for wireless calendar
synchronization:
e \Visit http://support.microsoft.com/kb/913643 to download and install the required hotfix on the messaging server.
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e Visit http://support.microsoft.com/kb/923537/en-us to download and install the required hotfix on the computer that
will host the BlackBerry Enterprise Server.

You must complete this task for all Microsoft Exchange versions to ensure calendar items use the correct Unicode
characters in fields such as subject, location, or notes.

1.  Onthe BlackBerry Enterprise Server, on the Start menu, click Run.

2 Type regedit.
3. Click OK.
4

Perform one of the following actions:

e [fyou are running a 32-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion
\BlackBerry Enterprise Server\Agents.

e [fyou are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\WOW6432Node
\Research In Motion\BlackBerry Enterprise Server\Agents.

5. Create a DWORD value that is named SetLocalelDs.
6. Setthevaluetol.

7. Inthe Windows Services, restart the BlackBerry Messaging Agent.

Configuring the BlackBerry Enterprise
Server to use Microsoft Exchange Web
Services

By default, the BlackBerry Enterprise Server uses Microsoft Exchange Web Services to manage calendars on BlackBerry
devices. The BlackBerry Enterprise Server monitors periodically whether a user account can use Microsoft Exchange Web
Services. If a user account cannot use Microsoft Exchange Web Services, for example, because of a configuration error in
Microsoft Exchange, the BlackBerry Enterprise Server uses MAPI and CDO libraries to manage calendars on devices. A
BlackBerry Messaging Agent on the BlackBerry Enterprise Server can include a dynamic mix of user accounts that use
Microsoft Exchange Web Services and user accounts that use MAPI and CDO libraries.

You can use the BlackBerry Enterprise Trait Tool to configure the BlackBerry Enterprise Server to use only Microsoft
Exchange Web Services or only MAPI and CDO libraries to manage calendars on devices. You can configure a specific
BlackBerry Messaging Agent instance, a specific BlackBerry Enterprise Server instance, or all BlackBerry Enterprise Server
instances that share one BlackBerry Configuration Database.

To use Microsoft Exchange Web Services, your organization's environment must include Microsoft Exchange 2007 SP1 or
later.
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For more information about Microsoft Exchange Web Services, visit http://msdn.microsoft.com/en-us/library/
bb204119.aspx.

For more information about configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services, see the
BlackBerry Enterprise Server Administration Guide.

Prerequisites: Configuring the BlackBerry Enterprise
Server to use Microsoft Exchange Web Services

e Install an SSL certificate on a BlackBerry Enterprise Server so that the BlackBerry Enterprise Server can communicate
with Microsoft Exchange Web Services. You must export the SSL certificate from the client access server for Microsoft
Exchange and import the SSL certificate to the BlackBerry Enterprise Server. The BlackBerry Enterprise Server
supports a self-signed security certificate or a certificate that a certificate authority issues. For more information about
installing an SSL certificate, visit support.microsoft.com to read article KB 962624.

e Configure Microsoft Exchange Impersonation for a BlackBerry Enterprise Server administrator account. For more
information about configuring Microsoft Exchange Impersonation, visit msdn.microsoft.com/en-us/library/
bb204095.aspx and select the appropriate tab for Microsoft Exchange 2007 or Microsoft Exchange 2010.

e Assign IIS permissions to a BlackBerry Enterprise Server administrator account on the Microsoft Exchange Server that
hosts the client access server role. For more information about assigning IIS permissions, visit support.microsoft.com to
read article KB 816117.

Configure the BlackBerry Enterprise Server to use
Microsoft Exchange Web Services

You can configure the BlackBerry Enterprise Server to use only Microsoft Exchange Web Services to manage calendars on
BlackBerry devices.

1.  Copy the BlackBerry Enterprise Server installation files to the computer that hosts the primary BlackBerry Enterprise
Server.

2. Extract the contents to a folder on the computer.
3. Atacommand prompt, navigate to <extracted_folder>\tools.

4.  Perform one of the following actions:

e To configure a specific BlackBerry Messaging Agent on a specific BlackBerry Enterprise Server to use Microsoft
Exchange Web Services, type traittool -server <server_name> -agent <agent_id> -trait EWSEnable -set true,
where <server_name> is the name of the BlackBerry Enterprise Server and <agent_id> is the ID for the
BlackBerry Messaging Agent. If you configured high availability, configure only the primary BlackBerry Enterprise
Server.
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5.

e To configure all BlackBerry Messaging Agent instances on a specific BlackBerry Enterprise Server to use
Microsoft Exchange Web Services, type traittool -server <server_name> -trait EWSEnable -set true, where
<server_name> is the name of the BlackBerry Enterprise Server. If you configured high availability, configure only
the primary BlackBerry Enterprise Server.

e Toconfigure all BlackBerry Messaging Agent instances on all BlackBerry Enterprise Server instances to use
Microsoft Exchange Web Services, type traittool -global -trait EWSEnable -set true.

Restart the BlackBerry Messaging Agent instances that you made changes to.

After you finish:

In the logs folder verify that the file named <server_name>_CALH_<agent_id>_<date>.txt appears. In the file name,
<server_name> is the name of the BlackBerry Enterprise Server, <agent_id> is the ID of the BlackBerry Messaging Agent,
and <date> is the date that you configured the BlackBerry Enterprise Server to use Microsoft Exchange Web Services.

Manage the BlackBerry Enterprise Server
performance in a Microsoft Exchange 2010
environment

Before you begin:

You must install version 6.5.8211.0 of the Microsoft Exchange Server MAPI Client and CDO 1.2.1 on the BlackBerry
Enterprise Server computer. For more information, visit www.microsoft.com/downloads to read the article named
"Microsoft Exchange Server MAPI Client and Collaboration Data Objects 1.2.1".

1.
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Verify that you configured Microsoft Exchange 2010 performance as suggested by Microsoft. For more information,
visit technet.microsoft.com to read "Understanding the Mailbox Database Cache" in the Microsoft Exchange 2010
SP1 help.

If necessary for your organization’s environment, verify that you installed the Microsoft hotfixes that are located in the
following articles:
e 2155311

e 979149

For more information about the hotfixes, visit support.microsoft.com.

Configure the BlackBerry Enterprise Server to use Microsoft Exchange Web Services to manage calendars on devices.
For more information, see "Configuring the BlackBerry Enterprise Server to use Microsoft Exchange Web Services or
MAPI and CDO libraries" in the BlackBerry Enterprise Server Administration Guide. BlackBerry Enterprise Server
defaults to using LDAP to retrieve email addresses and organizer data upon installation.
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Configure a Hosted BlackBerry services
environment for use with Microsoft
Exchange 2010 SP1 Multi-Tenant

Deployment

1. Verify that you configured the Microsoft Exchange 2010 messaging environment and completed the tasks "Configure
a management role for Microsoft Exchange Web Services" and "Configure the BlackBerry Enterprise Server to run
without public folders". For more information, see "Configuring a Microsoft Exchange 2010 messaging environment".

2. Configure Hosted BlackBerry services. If possible, make sure that your organization’s customers have full control of
their subtree in Microsoft Active Directory. For more information, see "Configure Hosted BlackBerry services when
your organization’s customers have full control of their subtree in Microsoft Active Directory" in the BlackBerry
Enterprise Server Administration Guide.

Configure the BlackBerry Administration
Service instances in a pool to communicate
across network subnets

The instances in the BlackBerry Administration Service pool use multicast UDP to communicate with each other. If the
BlackBerry Administration Service instances are located in different network subnets and your organization's network
configuration does not permit multicast UDP across the network subnets, you must configure the BlackBerry
Administration Service instances to use TCP to communicate with each other. For example, if your organization uses a UDP
peer-to-peer firewall filter, you must configure the BlackBerry Administration Service instances to use TCP to communicate
across the network subnets.

1.  Make sure that no BlackBerry Administration Service instance is in the process of restarting.

2. Inthe BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain > Component view > BlackBerry Administration Service.

3.  Click Edit component.
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4.  Inthe BlackBerry Administration Service pool drop-down list, click TCP with TCP PING.
5. Click Save all.

6. Restart the BlackBerry Administration Service instances.

Log in to the BlackBerry Administration
Service for the first time

To open the BlackBerry Administration Service, you can use a browser on any computer that has access to the computer
that hosts the BlackBerry Administration Service.

Before you begin: To manage a BlackBerry device using the BlackBerry Administration Service while the BlackBerry
device is connected to the computer, the browser must permit Microsoft ActiveX controls.

1. Inthe browser, type https://<server_name>/webconsole/app, where <server_name> is the name of the computer
that hosts the BlackBerry Administration Service.

In the User name field, type admin.
In the Password field, type the password that you created during the installation process.

In the Log in using drop-down list, click BlackBerry Administration Service or Active Directory Authentication.

ok wn

Click Log in.

There is a problem with this website's security
certificate

Description

The browser displays this error message when you try to navigate to the BlackBerry Administration Service using Windows
Internet Explorer version 7 or later.

Possible solution

Add the web address for the BlackBerry Administration Service to the list of trusted web sites in Windows Internet Explorer,
and install the certificate for the BlackBerry Administration Service in the certificate store of your computer.

1. InWindows Internet Explorer, navigate to the BlackBerry Administration Service console.
2. Click Continue to this website (not recommended).

3. Onthe Tools menu, click Internet Options.
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On the Security tab, click Local Intranet.

Click Sites.

Click Add to add the console to the list of trusted web sites.
Click Close.

Click OK.
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In the browser window, on the toolbar, click Certificate Error.
10. Click View certificates.
11. Click Install certificate. The Certificate Import Wizard opens.

12. Complete the instructions in the Certificate Import Wizard. If you are trying to log in to the BlackBerry Administration
Service using a computer that runs Windows Vista, perform the following actions in the Certificate Import Wizard.

a Inthe Certificate Store dialog box, click Place all certificates in the following store.
b Click Browse.

¢ Click Trusted Root Certification Authorities.

d Click OK.

13. Close and reopen the browser.

Configuring communication with distributed
components

Connecting to a BlackBerry Attachment Service

Perform the following actions if you installed the BlackBerry Attachment Service on a computer that is separate from the
computer that host the BlackBerry Enterprise Server or BlackBerry Enterprise Server components that connect to the
BlackBerry Attachment Service. These actions ensure that BlackBerry Enterprise Server components can connect to the
BlackBerry Attachment Service.

Connect a BlackBerry MDS Connection Service to a remote BlackBerry
Attachment Service

Perform the following task if you did not install the BlackBerry Attachment Service on the same computer as the
BlackBerry MDS Connection Service.
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1. Inthe BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain > Component view > Attachment > Connector.

2. Click the BlackBerry Attachment Connector that is installed with the BlackBerry MDS Connection Service.
3.  Click Edit instance.

4.  Onthe Supported Attachment Server instances tab, in the Name drop-down list, select the BlackBerry Attachment
Service instance that you want to connect the BlackBerry MDS Connection Service to.

5. Inthe Results query period(s) field, type the number of seconds that you want the BlackBerry MDS Connection
Service to wait for a response before it sends a request to another BlackBerry Attachment Service instance.

6. Inthe Dedicated server drop-down list, click yes if you want the BlackBerry Attachment Service instance to process
specific content types only for the BlackBerry MDS Connection Service.

7. Inthe Pool drop-down list, perform one of the following actions:

e Toinclude the BlackBerry Attachment Service instance in the primary group of instances in a pool, select
Primary. You must include at least one BlackBerry Attachment Service instance in the primary group. If you are
not configuring high availability, select Primary.

e Toinclude the BlackBerry Attachment Service instance in the secondary group, select Secondary.

8.  Perform the following actions:

e Toturnon support for an attachment file format, in the Extensions section, type the file extension of the format.
Click the Add icon beside the extension that you typed.

e To turn off support for an attachment file format, in the Extensions section, click the Delete icon beside the file
extension.

9.  Click the Add icon.
10. Click Save All.

11. Repeatsteps 2 to 10 for each BlackBerry MDS Connection Service instance in your organization's environment that
requires the BlackBerry Attachment Service instance.

Connect the BlackBerry Collaboration Service to a remote BlackBerry
Attachment Service

Using the BlackBerry Client for IBM Sametime, users can send files to contacts in their contact lists. To optimize files for
viewing on BlackBerry devices, the BlackBerry Collaboration Service must connect to a BlackBerry Attachment Service
instance. If you did not install the BlackBerry Attachment Service instance on the same computer as the BlackBerry
Collaboration Service, you must connect the BlackBerry Collaboration Service to a remote BlackBerry Attachment Service.

1.  Onthe computer that hosts the BlackBerry Collaboration Service, navigate to C:\Program Files\Research In Motion
\BlackBerry Enterprise Server\BBIM\Servers\<server_names\config.

2. Inatext editor, open the rimpublic.property file.
3. Attheend of the file, type the following text on separate lines:

Attachment.Server.host=<attachment_server_host_name>
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9.
10.

Attachment.Server.port.asp=1900
Attachment.Server.port.rqp=2000

To connect another BlackBerry Collaboration Service to the BlackBerry Attachment Service instance, type the text
that appears in step 3 for this BlackBerry Collaboration Service instance.

Save and close the file.
In the Windows Services, restart the BlackBerry Collaboration Service.

On the computer that hosts the BlackBerry Attachment Service, in the Registry Editor, navigate to
HKEY_LOCAL_MACHINE\SOFTWARE\Research In Motion\BBAttachServer\BBAttachBESExtension.

On the computer that hosts the BlackBerry Attachment Service, in the Registry Editor, perform one of the following
actions:

e [fyou are running a 32-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion
\BBAttachServer\BBAttachBESExtension.

e |fyou are running a 64-bit version of Windows, navigate to HKEY_LOCAL_MACHINE\Software\WOW6432Node
\Research In Motion\BBAttachServer\BBAttachBESExtension.

Change AllowRemoteServices to 1.

In the Windows Services, restart the BlackBerry Attachment Service.

Connect a BlackBerry Enterprise Server to a remote BlackBerry
Attachment Service

Perform the following actions if you did not install the BlackBerry Attachment Service on the same computer as the
BlackBerry Enterprise Server. The BlackBerry Messaging Agent requires access to the remote BlackBerry Attachment
Service so that it can process attachment requests.

1.

In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain > Component view > Attachment > Connector.

Click the BlackBerry Attachment Connector that is installed with the BlackBerry Enterprise Server.
Click Edit instance.

On the Supported Attachment Server instances tab, in the Name drop-down list, select the BlackBerry Attachment
Service instance that you want to connect to the BlackBerry Enterprise Server.

In the Results query period(s) field, type the number of seconds that you want the BlackBerry Enterprise Server to
wait for a response before it sends a request to another BlackBerry Attachment Service instance.

In the Dedicated server drop-down list, click yes if you want the BlackBerry Attachment Service instance to process
specific content types only for the BlackBerry Enterprise Server.

In the Pool drop-down list, perform one of the following actions:

e Toinclude the BlackBerry Attachment Service instance in the primary group of instances in a pool, select
Primary. You must include at least one BlackBerry Attachment Service instance in the primary group. If you are
not configuring BlackBerry Attachment Service high availability, select Primary.
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e Toinclude the BlackBerry Attachment Service instance in the secondary group, select Secondary.

8.  Perform the following actions:

e Toturnon support for an attachment file format, in the Extensions section, type the file extension of the format.
Click the Add icon beside the extension that you typed.

e Toturn off support for an attachment file format, in the Extensions section, click the Delete icon beside the file
extension.

9.  Click the Add icon.
10. Click Save All.

11. Repeatsteps 2 to 10 for each BlackBerry Enterprise Server instance in your organization's environment that requires
the BlackBerry Attachment Service instance.

12. Restart the BlackBerry Enterprise Server.
a. Inthe Component view, expand BlackBerry Enterprise Server.

b.  Click the BlackBerry Enterprise Server instance.

C. Click Restart instance.

Connect a remote BlackBerry Attachment Service to a BlackBerry
Enterprise Server

Perform the following actions if you did not install the BlackBerry Attachment Service on the same computer as the
BlackBerry Enterprise Server. The BlackBerry Messaging Agent requires access to the remote BlackBerry Attachment
Service so that it can process attachment requests.

1. Inthe BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain > Component view > Attachment > Server.

2. Click the name of the remote BlackBerry Attachment Service.
3. Click Edit instance.

4.  Onthe Supported Attachment Connector instances tab, add the BlackBerry Attachment Connector that is installed
with the BlackBerry Enterprise Server.

5. Click Save All.

6. Torestart the BlackBerry Attachment Service, on the Instance information tab, in the Status list, click Restart
instance.

Connecting to a BlackBerry Router

Perform the following tasks if you installed the BlackBerry Router on a computer that is separate from the computer that
hosts the BlackBerry Enterprise Server. These tasks ensure that the BlackBerry Enterprise Server can connect to the
BlackBerry Router.
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Permit a BlackBerry Enterprise Server to connect to a remote BlackBerry
Router

If you installed a BlackBerry Router on a computer that is separate from the computer that hosts a BlackBerry Enterprise
Server, you must permit the BlackBerry Dispatcher that you installed with the BlackBerry Enterprise Server to connect to
the BlackBerry Router. The BlackBerry Router that you installed on a separate computer can send data packets from the
BlackBerry Enterprise Server to BlackBerry devices.

1.

2
3.
4

On the computer that hosts the BlackBerry Router, click Start > Run.
Type regedit.
Click OK.

Perform one of the following actions:

e [fyou are running a 32-bit version of Windows, navigate to \HKEY_LOCAL_MACHINE\SOFTWARE\Research In
Motion\BlackBerryRouter.

e Ifyou are running a 64-bit version of Windows, navigate to \HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node \Research In Motion\BlackBerryRouter.

Verify the value of AllowRemoteServices is 1.

If you want to change the port number that the BlackBerry Router uses to open connections to the BlackBerry
Dispatcher, change the value of ServicePort to the port number that the BlackBerry Router should use, for example,
port number 80. By default, the port numberis 3101.

In the Windows Services, restart the BlackBerry Router service.

Connect a BlackBerry Enterprise Server to a remote BlackBerry Router

1.

In the BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain > Component view > BlackBerry Enterprise Server.

Click the BlackBerry Enterprise Server instance or BlackBerry Enterprise Server pair that you want to assign the
BlackBerry Router to.

Click Edit instance.
In the Router address section, type the FQDN of the computer that hosts the BlackBerry Router.

If the BlackBerry Router uses a port number other than port number 3101, in the Port override field, type the port
number.

Click the Add icon.
Click Save All.
Restart the BlackBerry Enterprise Server using one of the following methods:

e [fyouchanged a BlackBerry Enterprise Server instance, on the Instance tab, click Restart instance.
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e |fyou changed a BlackBerry Enterprise Server pair, click one of the instances and on the Instance tab, click
Restart instance. Repeat this step for the other instance.

e |nthe Windows Services, restart the BlackBerry Dispatcher.

Configuring a computer for monitoring

Configure the SNMP service for monitoring by a
monitoring application

You can configure the SNMP service on the computer that hosts the BlackBerry Enterprise Server so that the a monitoring
application can monitor BlackBerry Enterprise Server activity.

Before you begin: Verify that the SNMP service is installed and running.

1.
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On a computer that hosts the BlackBerry Enterprise Server or BlackBerry Enterprise Server components, in the
Windows Services, right-click SNMP Service. Click Properties.

On the General tab, change the startup type to Automatic.

On the Traps tab, in the Community name field, type the community name for the SNMP service. The field is case-
sensitive.

In the Trap Destinations section, add the IP address of the computer that hosts the monitoring application.

On the Security tab, in the Accepted community names section, add the community name that you typed in step 3.
The SNMP community name is read-only.

Select the Accept SNMP packets from any host or Accept SNMP packets from these hosts option, depending on
your organization's environment.

If you selected Accept SNMP packets from these hosts, type the IP address of the computer that hosts the
monitoring application.

Click Apply.
In the Services list, right-click SNMP Service. Click Restart.



Installation and Configuration Guide Postinstallation tasks

Restrict database permissions for the
BlackBerry Attachment Service

The BlackBerry Attachment Service accesses the BlackBerry Configuration Database to read attachment data using a
Windows account or a SQL authentication account. To limit the access that the BlackBerry Attachment Service account
has to the tables in the BlackBerry Configuration Database, you can configure a BlackBerry Attachment Service account
that has limited database permissions. This account is not the same as the account that the BlackBerry Enterprise Server
uses to access the BlackBerry Configuration Database.

Before you begin:
Create a Windows account for the BlackBerry Attachment Service.

To use database authentication, create a SQL authentication account for the BlackBerry Attachment Service.

In the Microsoft SQL Server management console, create a SQL login for the Windows account or SQL authentication
account.

Assign the account to the rim_db_AttachmentServer role in the BlackBerry Configuration Database.

If you want the BlackBerry Attachment Service to use a SQL authentication account to access the BlackBerry
Configuration Database, perform the following actions:

a.

On the computer that you installed the BlackBerry Attachment Service on, log in using the Windows account
that the BlackBerry Attachment Service is running on.

Click Start > Run.
Type regedit. Click OK.

If you are running a 32-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE\Research In
Motion.

If you are running a 64-bit version of Windows, navigate to HKEY_CURRENT_USER\SOFTWARE
\WOW6432Node\Research In Motion.

Create the BBAttachServer\Database keys.

In the Database key, create the Login and Password string values for the SQL authentication account.

After you finish: After you complete the BlackBerry Attachment Service installation process, in the Windows Services,
verify that the service for the BlackBerry Attachment Service is using the Windows account that you configured. If you need
to change the account information, restart the BlackBerry Attachment Service.
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Configuring minimum Microsoft SQL Server
permissions for the Windows account

The BlackBerry Enterprise Server setup application requires the Windows account that it uses during the installation
process or upgrade process to have Microsoft SQL Server permissions to create or upgrade the BlackBerry Configuration
Database. The setup application requires the Windows account to have more Microsoft SQL Server permissions to install
the BlackBerry Enterprise Server than the BlackBerry Enterprise Server requires to run.

After the installation or upgrade process completes, you can change the Microsoft SQL Server permissions of the Windows
account to the Microsoft SQL Server permissions that the BlackBerry Enterprise Server requires to run. When you change
the Microsoft SQL Server permissions of the Windows account, you can use Microsoft SQL Server security to minimize the
operations that the Windows account can perform on the BlackBerry Configuration Database.

The following table describes the Microsoft SQL Server permissions for the setup application and the Windows account that
the BlackBerry Enterprise Server uses to run.

Server and database roles Description

db_owner The setup application requires this role to upgrade the BlackBerry Configuration Database.

This role is the default permission in Microsoft SQL Server for running the BlackBerry
Enterprise Server.

rim_db_bes_server The setup application or the createDB executable creates the role automatically when it
creates the BlackBerry Configuration Database.

This role is the minimum permission in Microsoft SQL Server for running the BlackBerry
Enterprise Server.

Configure minimum Microsoft SQL Server permissions
for the Windows account

You can configure the minimum Microsoft SQL Server permissions for the Windows account that the BlackBerry Enterprise
Server uses to run.

1. Open the Microsoft SQL Server console.

2 Expand Microsoft SQL Server > Security > Logins.

3.  Right-click the Windows account that the BlackBerry Enterprise Server uses to run. Click Properties.
4

Map the Windows account to the BlackBerry Configuration Database.
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5. Change the Database role membership to rim_db_bes_server.
6. Remove all other database role memberships.

7. Apply your changes.

Changing the BlackBerry Configuration
Database

If you want a BlackBerry Enterprise Server to use a different BlackBerry Configuration Database, you must run the setup
application and specify the BlackBerry Configuration Database that you want the BlackBerry Enterprise Server to use.

When you change the BlackBerry Configuration Database, the BlackBerry Enterprise Server becomes unavailable and
users cannot send or receive messages on their BlackBerry devices. Organizer data synchronization occurs after you have
changed the BlackBerry Configuration Database.

Provisioning the BlackBerry Collaboration
Service as a trusted application

If you install Microsoft Office Communications Server 2007 R2 or Microsoft Lync Server 2010 for instant messaging, you
must provision the BlackBerry Collaboration Service as a trusted application in Microsoft Active Directory.

If you add the Windows account that runs the BlackBerry Collaboration Service to the RTCUniversalServerAdmins group,
the BlackBerry Collaboration Service is automatically provisioned as a trusted application. The RTCUniversalServerAdmins
group is created when you install Microsoft Office Communications Server 2007 R2 or Microsoft Lync Server 2010.

If you do not add the Windows account that runs the BlackBerry Collaboration Service to the RTCUniversalServerAdmins
group, you must manually provision each BlackBerry Collaboration Service instance as a trusted application. If you change
the listening port number or if the FQDN of the instant-messaging pool changes, you need to repeat the manual
provisioning task. If you restart the BlackBerry Collaboration Service, you do not need to repeat the manual provisioning
task.

Manually provision the BlackBerry Collaboration
Service as a trusted application

Before you begin:

79



Installation and Configuration Guide Postinstallation tasks

e Make sure that the Windows account that you use to complete this task is a member of the RTCUniversalServerAdmins
group or a group with similar permissions.

Turn off automatic configuration of the BlackBerry Collaboration Service as a trusted application.

1.  Onthe computer that hosts the BlackBerry Collaboration Service or on any computer that is in the BlackBerry
Enterprise Server domain, navigate to C:\Program Files (x86)\Research In Motion\BlackBerry Enterprise Server\BBIM
\bin.

2. Run the BCSProvisioner.exe file.

3. Inthe BCSProvisioner dialog box, perform the following actions to complete the provisioning process:

a. Inthe Office Communications Server Pool drop-down box, select the FQDN that you specified during the
BlackBerry Enterprise Server installation.

b.  Inthe BlackBerry Collaboration Service server FQDN field, type the FQDN of the computer that hosts the
BlackBerry Collaboration Service.

C. In the Listening port field, type the port number that you specified during the BlackBerry Enterprise Server
installation. The default port number is 65061.

d.  Click Provision BCS.

4. Inthe Windows Services, restart the BlackBerry Collaboration Service.

Turn off automatic provisioning of the BlackBerry
Collaboration Service as a trusted application

If you install Microsoft Office Communications Server 2007 R2 or Microsoft Lync Server 2010 for instant messaging and
you want to manually provision the BlackBerry Collaboration Service as a trusted application in Microsoft Active Directory,
you must first turn off automatic provisioning.

Before you begin: Make sure that the Windows account that runs the BlackBerry Collaboration Service is a member of
either the RTComponentUniversalServices group or the RTCUniversalServerAdmins group.

1.  Onthe computer that hosts the BlackBerry Collaboration Service, navigate to <drive>:\Program Files (x86)\Research
In Motion\BlackBerry Enterprise Server\BBIM\Servers\instance\config\.

In a text editor, open the rimpublic.property file.
At the end of the file, type improxy.RIMMSConnector.autoprovision=false.

Save and close the rimpublic.property file.

ok wn

In the Windows Services, restart the BlackBerry Collaboration Service.
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Adding or removing BlackBerry ENEE
Enterprise Server components

If you installed a BlackBerry Enterprise Server previously, you can add one or more BlackBerry Enterprise Server
components to the existing BlackBerry Enterprise Server, or you can remove existing BlackBerry Enterprise Server
components from the BlackBerry Enterprise Server.

To add or remove a BlackBerry Enterprise Server component, you must run the setup application again. The setup
application removes the existing BlackBerry Enterprise Server software from the computer, and installs only the BlackBerry
Enterprise Server components that you select. You can also choose to install either a BlackBerry Enterprise Server or install
one or more remote components.

If you installed a BlackBerry Enterprise Server and, when you run the setup application again you select the remote
component setup option, the setup application removes the existing BlackBerry Enterprise Server software. If you installed
one or more remote components and you select the BlackBerry Enterprise Server setup option, the setup application
removes the existing remote components.

You can add or remove the following BlackBerry Enterprise Server components.

Component Options

BlackBerry Enterprise Server You can choose one of the following options:

e You can remove a BlackBerry Enterprise Server (which includes a
BlackBerry Attachment Service, BlackBerry Dispatcher, BlackBerry MDS
Connection Service, BlackBerry Messaging Agent, BlackBerry Policy
Service, BlackBerry Router, and BlackBerry Synchronization Service) and
install one or more remote components instead.

e You can remove any remote components and install a BlackBerry Enterprise
Server instead.

BlackBerry Administration Service You can choose one of the following options:

e |fyou installed a BlackBerry Administration Service with a BlackBerry
Enterprise Server, you can remove the BlackBerry Administration Service.

e |fyou installed a BlackBerry Enterprise Server, you can add a BlackBerry
Administration Service.

e |fyou installed a BlackBerry Administration Service as a remote component,
you can remove it.
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Component

BlackBerry Attachment Service

BlackBerry Collaboration Service

BlackBerry MDS Connection Service

BlackBerry Router
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Options

e |fyou installed remote components, you can add a BlackBerry
Administration Service.

You can choose one of the following options:
e |fyou installed a BlackBerry Attachment Service as a remote component,
you can remove it.

e Youcan add a BlackBerry Attachment Service to an existing installation of
another remote component.

You can choose one of the following options:
e |fyou installed a BlackBerry Collaboration Service with a BlackBerry
Enterprise Server, you can remove the BlackBerry Collaboration Service.

e |fyou installed a BlackBerry Enterprise Server, you can add a BlackBerry
Collaboration Service.

e |fyou installed a BlackBerry Collaboration Service as a remote component,
you can remove it.

e |fyou installed remote components, you can add a BlackBerry Collaboration
Service.

You can choose one of the following options:

e [fyouinstalled a BlackBerry MDS Connection Service as a remote
component, you can remove it.

e Youcan add a BlackBerry MDS Connection Service to an existing installation
of another remote component.

You can choose one of the following options:

e |fyou installed a BlackBerry Router as a remote component, you can remove
it.

e You can add a BlackBerry Router to an existing installation of another
remote component.
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Add or remove a BlackBerry Enterprise
Server component

When you add or remove a BlackBerry Enterprise Server component, the components on the computer that you perform
this task on are unavailable for use until the installation or removal process is complete and you restart the BlackBerry
Enterprise Server services.

The process includes a restart of the BlackBerry Enterprise Server.

Before you begin:

e |fyou configured high availability and you want to add or remove a BlackBerry Enterprise Server component from a
computer that hosts a primary BlackBerry Enterprise Server instance, perform a manual failover to the standby
BlackBerry Enterprise Server so that users are not affected by the adding or removing of a BlackBerry Enterprise Server
component.

e [fyou configured database mirroring for the BlackBerry Configuration Database, you must verify that the BlackBerry
Enterprise Server is connected to the principal database before you run the setup application.

e |fyouwanttoremove a BlackBerry Router, BlackBerry Attachment Service, BlackBerry MDS Connection Service, or
BlackBerry Collaboration Service, use the BlackBerry Administration Service to remove the component from the list of
component instances that the BlackBerry Enterprise Server instances use.

1. Logintoacomputer using the Windows account that you used to install the BlackBerry Enterprise Server
components.
2. Stop the BlackBerry Enterprise Server services.

3. Inthe BlackBerry Enterprise Server installation files, double-click setup.exe. If your operating system is Windows
Server 2008, run setup.exe as an administrator.

4. Inthe Setup type dialog box, select Use an existing BlackBerry Configuration Database.

5. Inthe Database information dialog box, perform the following actions:

e Verify the names of the database server and BlackBerry Configuration Database that the BlackBerry Enterprise
Server instances use.

e [fyou configured the database server to use static ports, select the Static option. If the static port number is not
1433, in the Port field, type the port number.

6. Ifyouwant to configure database mirroring, in the Database mirroring options dialog box, you can select Add
support for database mirroring and type the name of the database server that hosts the mirror database in the Name
of the mirror database server field. The setup application does not create the BlackBerry Configuration Database on
the mirror Microsoft SQL Server; it adds a registry key to the computer that includes the name of the mirror Microsoft
SQL Server.
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7.  Inthe Setup options dialog box, select the components that you want to add and clear the checkboxes for the
components that you want to remove. The setup application upgrades any components that you installed previously
that you select and the components might be unavailable for users during the installation process.

In the MAPI Settings dialog box, click OK.
9. Ifthe setup application prompts you to restart the computer, click Yes.
10. Login tothe computer using the same account that you used in step 1.

11. Inthe Administration settings dialog box, consider the following information:

e |nthe Pool name field, type a valid FQDN or IP address. The setup application uses the FQDN or IP address to
create the BlackBerry Administration Service web address.

e You must type the password for the SSL certificate that the BlackBerry Administration Service uses for
authentication with browsers.

12. Inthe Microsoft Active Directory settings dialog box, in the User password field, type the password for the Microsoft
Active Directory account (for example, BESAdmin) that the BlackBerry Enterprise Server instance uses to
authenticate with Microsoft Active Directory. If you want to specify a different username and Windows domain, you
must make sure that the Windows domain belongs to the Microsoft Active Directory forest that the Microsoft
Exchange organization belongs to.

13. Inthe Advanced administration settings dialog box, perform one of the following actions:
e [fyou select Use Windows authentication, you can choose to use the Microsoft Active Directory account that you
used in the previous step, or you can specify login information for a Microsoft Active Directory administrator.

e |fyou select Use BlackBerry Administration Service authentication, type and confirm a password for the
BlackBerry Administration Service administrator account. Consider using the minimum rules for password
complexity when you create the password for the administrator account. The password should be at least 8
characters in length and contain at least one number, letter, and special character, and should not contain
dictionary words.

You use the login information that you specify to log in to the BlackBerry Administration Service for the first time.
14. Start the services for the BlackBerry Enterprise Server instance.

15. Inthe Console addresses dialog box, copy the web addresses for the BlackBerry Enterprise Server components and
paste them into a document for future reference. You can use the web addresses to log in to the BlackBerry
Enterprise Server components.

After you finish:
e |fyou added a component, to view the component information in the BlackBerry Administration Service, perform one of
the following actions:

e Restart the BlackBerry Administration Service.

e Onevery computer that hosts the BlackBerry Administration Service, in the BlackBerry Administration Service, in
the Servers and components menu, expand BlackBerry Solution topology > BlackBerry Domain. Click
Component view and then click Refresh list of registered components.

e [fyouremoved a component other than the BlackBerry Router, to delete the component information from the
BlackBerry Configuration Database, use the BlackBerry Administration Service.
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e |[fyou reinstalled the BlackBerry Administration Service, in, delete the cache content.

Remove BlackBerry Enterprise Server
component information from the
BlackBerry Configuration Database

If you remove the software for a BlackBerry Enterprise Server component from a computer, the software removal process

does not delete the component information from the BlackBerry Configuration Database. You must delete the information
manually using the BlackBerry Administration Service so that the BlackBerry Administration Service does not display the

information for the component that you removed.

Before you begin: Remove the software for the BlackBerry Enterprise Server component from the computer.

1. Inthe BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain.

2. Click Component view.
3.  Beside the component that you removed, which appears as Uninstalled, click the Delete icon.

4.  Click Yes - Delete the instance and wait until you return to the main page.
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Removing the BlackBerry
Enterprise Server software

Remove the BlackBerry Enterprise Server
software

1.  Onthe taskbar, click Start > Settings > Control Panel > Add/Remove Programs.
2. Click BlackBerry Enterprise Server.

3. Click Remove.

4.  Click Yes.

After you finish: To remove third-party software that the setup application installed during the BlackBerry Enterprise
Server installation process, you can remove the JRE software and Java Web Start software from the computer.

Delete registry keys

The BlackBerry Enterprise Server setup application might not remove all of the registry keys from the Windows registry
when you remove the BlackBerry Enterprise Server software. You can remove the registry keys from the Windows registry
manually after the process to remove the BlackBerry Enterprise Server software completes successfully.

1.  Onthe computer that you removed the BlackBerry Enterprise Server software from, on the Start menu, click Run.
2 Type regedit.
3. Click OK.
4

Delete the remaining registry keys.
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BlackBerry Enterprise Server registry keys

The setup application might not remove the following BlackBerry Enterprise Server registry keys from the Windows Registry

when you remove the BlackBerry Enterprise Server software.

Key

Research In Motion

BBAttachServer and any keys that start with BAS, BB, or
BlackBerry

BBAttachServer and any keys that start with BAS, BB, or
BlackBerry

BBAttachServer and any keys that start with BAS, BB, or
BlackBerry

Research In Motion

any keys that are named BlackBerryServer, or are named
the name of the BlackBerry Enterprise Server in your
organization

Research In Motion

BESManmmc.dll

any key where ProductName is BlackBerry Enterprise
Server

Location

HKEY_LOCAL_MACHINE\SOFTWARE (32-bit OS)

HKEY_LOCAL_MACHINE\Wow6432Node\SOFTWARE (64-
bit OS)

HKEY_LOCAL_MACHINE\System\CurrentControlSet
\Services

HKEY_LOCAL_MACHINE\System\ControlSet001\Services

HKEY_LOCAL_MACHINE\System\ControlSetOOn\Services

HKEY_CURRENT_USER\Software

HKEY_CURRENT_USER\Software\Microsoft\Windows NT
\CurrentVersion\Windows Messaging SubSystem\Profiles

HKEY_USERS\.DEFAULT\Software

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
\CurrentVersion\App Paths

HKEY_CLASSES_ROOT\Installer\Products

re
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Removing the BlackBerry database
notification system

You must remove the BlackBerry database notification system manually if you installed it manually. You can remove the
BlackBerry database notification system from one BlackBerry Configuration Database instance or all BlackBerry
Configuration Database instances.

Remove the BlackBerry database notification system
from a BlackBerry Configuration Database

1. Openthe Microsoft SQL Server Management Studio.

2. Usingthe console, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry Enterprise Server
installation files.

Open the NotifyUnlinstall.sql file.
Delete all commands after --- delete notification stored procedures and -- delete notification tables.

Run the script.

o o A~ W

Perform one of the following actions:
e Restart Microsoft SQL Server.

e In Windows Explorer, navigate to C:\Program Files\Microsoft SQL Serve\MSSQL\Binn. Rename the RimEsp.dll file
(for example, RimEspXXX.tmp).

Remove the BlackBerry database notification system
from all BlackBerry Configuration Database instances

1. Open the Microsoft SQL Server Management Studio.

2. Using the console, navigate to Database\DBInstallScripts\SQLServer\5.0 in the BlackBerry Enterprise Server
installation files.

Open the NotifyUnlinstall.sql file.

&

Run the script.
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5.
6.

Using Windows Explorer, navigate to <drive>:\Program Files\Microsoft SQL Server\MSSQL\Binn.
Delete the RimEsp.dll file.
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Troubleshooting the
BlackBerry Enterprise Server
installation process

Failed to write License Key to the Database

This error message appears when you try to add the BlackBerry Client Access License key during the installation process.

Possible solution

After you restart the computer during the BlackBerry Enterprise Server installation process, you must log in using the same
Windows account that you used to start the installation process.

1. Close the setup application.
2. Logout of the computer.

3. Logintothe computer.
4

. Restart the setup application.

Previous version detected but no database
available

This error message appears when you cannot start the setup application or the setup application stops responding.

Possible solution
Verify that the registry keys that identify the BlackBerry Configuration Database exist in the Windows registry.

1. Onthe computer that you want to install or upgrade the BlackBerry Enterprise Server on, on the Start menu, click Run.

2. Type regedit.
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3. Click OK.

>

O N O o

In the left pane, navigate to HKEY_LOCAL_MACHINE\Software\Research In Motion\BlackBerry Enterprise Server
\Database.

If necessary, create case-sensitive strings that you name DatabaseName and DatabaseServerMachineName.
Specify the name of the BlackBerry Configuration Database as the value for DatabaseName.
Specify the FQDN name of the database server as the value for DatabaseServerMachineName.

Restart the setup application.

A third-party tool did not install and the
BlackBerry Enterprise Server setup
application closed

Possible solution

1.

On the BlackBerry Enterprise Server installation media, open the Tools folder.

2. Double-click the setup application file for the tool that you want to install.
3.
4

. Restart the BlackBerry Enterprise Server setup application.

Complete the instructions on the screen.

The setup application did not prompt you to
change or confirm the MAPI profile

Possible solution

Create and change the MAPI profile manually.

1.

On the BlackBerry Enterprise Server installation media, open the Tools folder.

2. Double-click the Fixmapisvc.exe file.
3.
4

. On the taskbar, click Start > All Programs > BlackBerry Enterprise Server > BlackBerry Server Configuration.

Verify that mapisvc.inf is installed in C:\winnt\system32\ or C:\windows\system32\.
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On the BlackBerry Server tab, click Edit MAPI profile.

Type the Microsoft Exchange server name.

Click the Windows account that is associated with the MAPI profile.
Click OK.

© N o o

You cannot determine the BlackBerry
Attachment Connector that the BlackBerry
Enterprise Server or the BlackBerry MDS
Connection Service uses

If you install a BlackBerry Enterprise Server, the setup application also installs two BlackBerry Attachment Connector
instances automatically. One of the BlackBerry Attachment Connector instances connects the BlackBerry Enterprise
Server to the BlackBerry Attachment Service. The other instance connects the BlackBerry MDS Connection Service to the
BlackBerry Attachment Service. During the installation process, the setup application gives both BlackBerry Attachment
Connector instances a name that includes the computer name (for example, <computer_name>_AC).

The BlackBerry Administration Service displays the names of both the BlackBerry Attachment Connector instances. By
default, you cannot determine easily which instance connects to the BlackBerry Enterprise Server or the BlackBerry MDS
Connection Service, so you can change the display names of both the BlackBerry Attachment Connector instances to
make them easier to identify.

1. Inthe BlackBerry Administration Service, on the Servers and components menu, expand BlackBerry Solution
topology > BlackBerry Domain > Component view > Attachment > Connector.

2. Click one of the BlackBerry Attachment Connector instances.

3. Onthe Instance information tab, locate either the MDS Connection Service Instance name section or the Email
(Exchange) Instance name section. Consider the following naming conventions:

e |fyou locate the section that is named MDS Connection Service Instance name, the BlackBerry MDS Connection
Service connects to this BlackBerry Attachment Connector instance.

e [fyou locate the section that is named Email (Exchange) Instance name, the BlackBerry Enterprise Server
connects to this BlackBerry Attachment Connector instance.

4. Click Edit instance.

Perform one of the following actions:
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e |fthe BlackBerry MDS Connection Service connects to the BlackBerry Attachment Connector instance, in the
Instance information section, in the Friendly description field, type a unique name (for example,
<server_name>_AC_MDSCS).

e |fthe BlackBerry Enterprise Server uses the BlackBerry Attachment Connector instance, in the Instance
information section, in the Friendly description field, type a unique name.

6. Click Save all.

The BlackBerry Administration Service updates the list of BlackBerry Attachment Connector instances automatically to
use the names that you typed.

Users experience unexpected behavior with
message lists and calendars on BlackBerry
devices

Possible cause

If the MAPI and CDO client version 6.5.8022 was installed without uninstalling previous versions of the MAPl and CDO
client (including the associated .DLL files), users might experience unexpected behavior with message lists and calendars
on BlackBerry devices.

Possible solution

For more information about Microsoft Exchange Server MAPI Client and CDO version 1.2.1, visit www.microsoft.com.

1. Inthe Windows Services, stop the services for the BlackBerry Enterprise Server and any processes that use the MAPI
and CDO client.

Remove the MAPI and CDO client version 6.5.8022.

3. Verify that the following files are not present in C:\Windows\System32 or any other directory in the environment path:

e (CDO.DLL

e EMSABP32.DLL
e EMSMDB32.DLL
e EMSUI32.DLL

e EMSUIX32.DLL
e GAPI32.DLL

e MAPISP32.EXE
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e MSPST32.DLL
e WMSUI32.DLL

4. In C:\Windows\System32, run the FixMapi.exe application.
5. Install the MAPI and CDO client version 6.5.8022.

6. Restart the services for the BlackBerry Enterprise Server and any processes that use the MAPI and CDO client.

If you run the BlackBerry Enterprise Server setup application after you complete the possible solution, when the setup
application displays the preinstallation checklist, an error message indicates that the setup application could not detect
the MAPI and CDO client. The setup application displays this error message because you installed the MAPI and CDO
client version 6.5.8022 in a different directory than the directory that you installed it in for previous versions. The error

message does not prevent the BlackBerry Enterprise Server setup application from completing the installation process
successfully.

Some BlackBerry Enterprise Server
components do not start

Possible cause Possible solution

The BlackBerry Administration Service, Configure a static port for the BlackBerry Configuration Database.
BlackBerry MDS Connection Service,
or BlackBerry Collaboration Service is
configured to use a dynamic port when

1. Onthe computer that hosts the BlackBerry Enterprise Server component, on
the taskbar, click Start > All Programs > BlackBerry Enterprise Server.

it connects to the BlackBerry 2. Right-click BlackBerry Server Configuration and select Run as
Configuration Database, but the administrator.
database server uses a static port. 3. Onthe Database Connectivity tab, clear the Use dynamic ports or specify
SQL port check box.
4. Inthe Use dynamic ports or specify SQL port field, type the correct port
number.
5. Click OK.

6. Inthe Windows Services, restart the services for the BlackBerry Enterprise
Server component.

The BlackBerry Administration Service, Configure the component to use the correct port number.
BlackBerry MDS Connection Service,
or BlackBerry Collaboration Service is
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Possible cause Possible solution

configured to use an incorrect static 1. On the computer that hosts the BlackBerry Enterprise Server component, on
port number when it connects to the the taskbar, click Start > All Programs > BlackBerry Enterprise Server.

BlackBerry Configuration Database. 2. Right-click BlackBerry Server Configuration and select Run as
administrator.

3. On the Database Connectivity tab, clear the Use dynamic ports or specify
SQL port check box.

4. Inthe Use dynamic ports or specify SQL port field, type the correct port
number.

5. Click OK.

In the Windows Services, restart the services for the BlackBerry Enterprise
Server component.

You cannot access the BlackBerry
Administration Service

Possible cause

The computer that hosts the BlackBerry Administration Service has more than one NIC and the production NIC is not first
in the bind order in Windows network settings as it must be for you to access the BlackBerry Administration Service.

Possible solution

On the computer that hosts the BlackBerry Administration Service, in the Windows network settings, verify that the
production NIC is first in the bind order. For more information, visit www.blackberry.com/btsc to read article KB18190.
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You cannot create a user account in the
BlackBerry Administration Service

Possible cause Possible solution

The BlackBerry Administration Service Configure the BlackBerry Administration Service to use a dynamic port for the
is configured to use static ports when it BlackBerry Configuration Database.

connects to the BlackBerry
Configuration Database server, but the

BlackBerry Configuration Database
server uses a dynamic port. 2. Right-click BlackBerry Server Configuration and select Run as
administrator.

1. Onthe computer that hosts the BlackBerry Enterprise Server component, on
the taskbar, click Start > All Programs > BlackBerry Enterprise Server.

3. Onthe Database Connectivity tab, select the Use dynamic ports or specify
SQL port check box.

4. Click OK.

In the Windows Services, restart the services for the BlackBerry
Administration Service.

The BlackBerry Administration Service pool
name is the same as the FQDN of the host
computer

Possible cause

A DNS record was not created before a BlackBerry Administration Service instance was installed.

Possible solution
1. Create the DNS record for the BlackBerry Administration Service instance.

2. Onthe computer that hosts the BlackBerry Enterprise Server component, on the taskbar, click Start > All Programs >
BlackBerry Enterprise Server.
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Right-click BlackBerry Server Configuration and select Run as administrator.

4. Onthe Administration Service - High Availability tab, in the Pool name field, type the name of the BlackBerry
Administration Service pool.

5. Inthe Windows Services, restart the services for the BlackBerry Administration Service.

The text in the license agreement is not
readable

Possible cause

You have not installed the appropriate languages and text services on the computer that you use to install the BlackBerry
Enterprise Server.

Possible solution

Verify that you installed the appropriate languages and text services on the computer that you use to install the BlackBerry
Enterprise Server.
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Related resources

To read the following guides or additional related material, visit http://www.blackberry.com/go/serverdocs.

Guide

What's New in BlackBerry Enterprise
Server 5.0 SP4 Job Aid

BlackBerry Enterprise Server Update
Guide

BlackBerry Enterprise Server Release
Notes

BlackBerry Enterprise Server Upgrade
Guide

BlackBerry Enterprise Server Policy
Reference Guide
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e Summary of new features

e Summary of updates to the administrator guides for BlackBerry Enterprise
Server 5.0 SP4

e Description of known issues and potential workarounds

e System requirements

e Upgrade instructions

e Descriptions of available IT policy rules and application control policy rules

e Descriptions of Wi-Fi configuration settings and VPN configuration settings
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AES
AJAX
BlackBerry CAL

BlackBerry Domain

BlackBerry MDS
CAS

CDMA

Ccbo

DMz

DNS
FQDN
HTTP
HTTPS

IS

IP

IP address

JDK
JRE
LAN
LDAP

Advanced Encryption Standard
Asynchronous JavaScript and XML

A BlackBerry Client Access License (BlackBerry CAL) limits how many users you can add to a
BlackBerry Enterprise Server.

A BlackBerry Domain consists of the BlackBerry Configuration Database with its users and any
BlackBerry Enterprise Server instances that connect to it.

BlackBerry Mobile Data System
Client Access Server

Code Division Multiple Access
Collaboration Data Object

A demilitarized zone (DMZ) is a neutral subnetwork outside of an organization's firewall. It exists
between the trusted LAN of the organization and the untrusted external wireless network and
public Internet.

Domain Name System

fully qualified domain name

Hypertext Transfer Protocol over Secure Sockets Layer
Hypertext Transfer Protocol over Secure Sockets Layer
Internet Information Services

Internet Protocol

An Internet Protocol (IP) address is an identification number that each computer or mobile
device uses when it sends or receives information over a network, such as the Internet. This
identification number identifies the specific computer or mobile device on the network.

Java Development Kit
Java Runtime Environment
local area network

Lightweight Directory Access Protocol

Glossary
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MAPI

messaging server

NIC
NSPI
RAID
SNMP
SQL
SRP
SSL
TCP
TCP/IP

TLS

Triple DES
UDP

VPN

WAN

XML
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Messaging Application Programming Interface

A messaging server sends and processes messages and provides collaboration services, such as
updating and communicating calendar and address book information.

network interface card

Name Service Provider Interface

redundant array of independent (or inexpensive) disks
Simple Network Management Protocol

Structured Query Language

Server Routing Protocol

Secure Sockets Layer

Transmission Control Protocol

Transmission Control Protocol/Internet Protocol (TCP/IP) is a set of communication protocols
that is used to transmit data over networks, such as the Internet.

Transport Layer Security

Triple Data Encryption Standard
User Datagram Protocol

virtual private network

wide area network

Extensible Markup Language
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Legal notice

©2014 BlackBerry. All rights reserved. BlackBerry® and related trademarks, names, and logos are the property of
BlackBerry Limited and are registered and/or used in the U.S. and countries around the world.

Safari is a trademark of Apple Inc. Google Chrome is a trademark of Google Inc. IBM, Lotus, and Sametime are trademarks
of International Business Machines Corporation. Intel and Xeon are trademarks of Intel Corporation. Microsoft, Active
Directory, ActiveX, Hyper-V, Internet Explorer, Lync, Outlook, SQL Server, Visual C++, Windows, Windows Media, Windows
Server, and Windows Vista are trademarks of Microsoft Corporation. Mozilla and Firefox are trademarks of Mozilla
Foundation. Java, JavaScript, JDK, and JRE are trademarks of Oracle and/or its affiliates. RSA is a trademark of RSA
Security. VMware vSphere is a trademark of VMware, Inc. All other trademarks are the property of their respective owners.

This documentation including all documentation incorporated by reference herein such as documentation provided or
made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without
condition, endorsement, guarantee, representation, or warranty of any kind by BlackBerry Limited and its affiliated
companies ("BlackBerry") and BlackBerry assumes no responsibility for any typographical, technical, or other
inaccuracies, errors, or omissions in this documentation. In order to protect BlackBerry proprietary and confidential
information and/or trade secrets, this documentation may describe some aspects of BlackBerry technology in generalized
terms. BlackBerry reserves the right to periodically change information that is contained in this documentation; however,
BlackBerry makes no commitment to provide any such changes, updates, enhancements, or other additions to this
documentation to you in a timely manner or at all.

This documentation might contain references to third-party sources of information, hardware or software, products or
services including components and content such as content protected by copyright and/or third-party websites
(collectively the "Third Party Products and Services"). BlackBerry does not control, and is not responsible for, any Third
Party Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility,
performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The
inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by
BlackBerry of the Third Party Products and Services or the third party in any way.

EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR
WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE
QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A
COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE
OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR
PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND
CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE
DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE
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HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM
THAT IS THE SUBJECT OF THE CLAIM.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL
BLACKBERRY BE LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR
PERFORMANCE OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY
PRODUCTS AND SERVICES REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING
DAMAGES: DIRECT, CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED
DAMAGES, DAMAGES FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION
OR LOSS OF DATA, FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY
APPLICATIONS USED IN CONJUNCTION WITH BLACKBERRY PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF
THE USE OF BLACKBERRY PRODUCTS OR SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST
OF SUBSTITUTE GOODS, COSTS OF COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR
PECUNIARY LOSSES, WHETHER OR NOT SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF
BLACKBERRY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, BLACKBERRY SHALL HAVE NO
OTHER OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING
ANY LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.

THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF
THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL
BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY
CONTAINED HEREIN; AND (B) TO BLACKBERRY AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS,
AGENTS, SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED BLACKBERRY DISTRIBUTORS (ALSO
INCLUDING AIRTIME SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT
CONTRACTORS.

IN'ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF BLACKBERRY OR ANY AFFILIATES OF
BLACKBERRY HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.

Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that
your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer
Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for
availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with
BlackBerry's products and services may require one or more patent, trademark, copyright, or other licenses in order to
avoid infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party
Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring
them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any
Third Party Products and Services that are provided with BlackBerry's products and services are provided as a
convenience to you and are provided "AS IS" with no express or implied conditions, endorsements, guarantees,
representations, or warranties of any kind by BlackBerry and BlackBerry assumes no liability whatsoever, in relation
thereto. Your use of Third Party Products and Services shall be governed by and subject to you agreeing to the terms of
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separate licenses and other agreements applicable thereto with third parties, except to the extent expressly covered by a
license or other agreement with BlackBerry.

Certain features outlined in this documentation require a minimum version of BlackBerry Enterprise Server, BlackBerry
Desktop Software, and/or BlackBerry Device Software.

The terms of use of any BlackBerry product or service are set out in a separate license or other agreement with BlackBerry
applicable thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN
AGREEMENTS OR WARRANTIES PROVIDED BY BLACKBERRY FOR PORTIONS OF ANY BLACKBERRY PRODUCT OR
SERVICE OTHER THAN THIS DOCUMENTATION.

Certain features outlined in this documentation might require additional development or Third Party Products and Services
for access to corporate applications.

This product contains a modified version of HTML Tidy. Copyright © 1998-2003 World Wide Web Consortium
(Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio
University). All Rights Reserved.

This product includes software developed by the Apache Software Foundation (www.apache.org/) and/or is licensed
pursuant to one of the licenses listed at (www.apache.org/licenses/). For more information, see the NOTICE.txt file included
with the software

BlackBerry Limited

2200 University Avenue East
Waterloo, Ontario

Canada N2K 0A7

BlackBerry UK Limited
200 Bath Road

Slough, Berkshire SL1 3XE
United Kingdom

Published in Canada
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Golf course search by state

http://golfingnear.com

Email search by domain

http://emailbydomain.com

Auto manuals search
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TV manuals search

http://tv.somanuals.com
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